
Diversity Workbench
The Diversity Workbench is composed of components for building and managing biodiversity
information, each of which focuses on a particular domain. Each component can provide
services to the other components. DiversityTaxonNames can link data to the
modules DiversityProjects, DiversityGazetteer, DiversityAgents,
DiversityCollection and DiversityReferences as illustrated in the image below.
DiversityTaxonNames itself is a source for other modules like DiversityCollection and
DiversityDescriptions.

 

The modules communicate with each other to provide their services for the other modules.
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Modules
The Diversity Workbench is a set of components for building and managing biodiversity
information, each of which focuses on a particular domain. To see the open connections to
other modules, choose Connection - Module connections .... from the menu. Each
component can provide services to the other components. The optional links to other modules
within the Diversity Workbench are shown in the image below. [DiversityGazetteer,
DiversityReferences, DiversityProjects, DiversityCollection]
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Module related entry
The Diversity Workbench  is a set of components for building and managing biodiversity
information, each of which focuses on a particular domain.  Each module provides services for
the other modules. To use the service of a module, you need access to the database of the
module and optionally the module application placed in your application directory. Entries
related to an external module have a standard interface in the main form. There are 2
states of this interface:

1 - the value is only set in the local database with no connection to the remote module

In this state, you can either type the value or select it from the values that are already
available in the database. To get a list of the available values type the beginning of the value

(you may use wildcards) and click on the  button. If you want to set a relation to the
remote module, click on the  button. A form will open where you may select an entry from
the foreign database.

 

2 - the value is related to the remote module 

If the value has a relation to the remote module, the interface will appear as shown above. To

release the connection to the remote module click the button. If you need further
information about the value, click the  button. This will open a form, showing an overview
of the related value. 
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If the client application of the module is available you can inspect the details of the entry.
To start the client application of the remote module, just click on the  button.  
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Projects
Projects with the DiversityWorkbench are located in the database DiversityProjects. The
access to the data is organized via projects. The projects a user has access to can be
selected in the query options.

 

To edit the project list use the project area. Use the  and  buttons to add or delete
projects from the list.

If there are projects, to which you have no access, an additional list will appear, showing
these projects (see below).

 

The information related to opinions of the editors are allways restricted to a certain project
(see Database).
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Reference
References are stored in several places within DiversityTaxonNames. Details about References
are stored in the module DiversityReferences. If you choose an entry from the references
stored in DiversityTaxonNames you can choose one of the entries in the picklist. 

If the module DiversityReferences is available, you can access this module by clicking on the 
button.

For access to the projects from other modules like DiversityTaxonNames, you need the
application DiversityReferences.exe  in your application directory. To use this application
you need access to the Database DiversityReferences. 
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Specimen
If you are connected to a DiversityCollection database (see menu Connection -> Module
connections ... . Of several databases, the first will be used), the program will search in this
database for type specimen, that are linked to the current name. These will be listed as
shown below.

To see a larger view of the image, just double click on it. To see further informations about
the specimen, click on the button.
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Index
 TaxonAcceptedName

 TaxonCommonName

 TaxonGeography

 TaxonHierarchy

 TaxonName

 TaxonNameExternalDatabase

 TaxonNameExternalID

 TaxonNameList

 TaxonNameListAnalysis

 TaxonNameListAnalysisCategory

 TaxonNameListAnalysisCategoryValue

 TaxonNameListArea

 TaxonNameListCollectionSpecimen

 TaxonNameListDistribution

 TaxonNameListImage

 TaxonNameListProjectProxy

 TaxonNameListReference

 TaxonNameProject

 TaxonNameReference

 TaxonNameResource

 TaxonNameTypification

 TaxonSynonymy

Table TaxonAcceptedName
TaxonAcceptedName contains the accepted names ("valid or preferred taxon
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names"). For each project, a name in "TaxonName" may either be accepted
(a corresponding record in "TaxonAcceptedName" exists) or not. Examples
for not accepted names are synonyms of accepted names and
nomenclaturally rejected names.

Column Data type Description Nullable Relation

ProjectID int

Each project
can have a
different opinion
regarding
synonmy. Refers
to the common
project definition
in the
DiversityProjects
module.
Default value: 0

NO

Refers to table
ProjectProxy and
table
TaxonNameProjec
t

NameID int

ID of the
accepted name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO
Refers to table
TaxonNameProjec
t

IgnoreButKeepForReferenc
e tinyint

If true, the
record is ignored
for all purposes
of evaluation
(because
contradicted). It
is kept only to
maintain the
cited reference.
If no reference
is given, it may
be deleted
instead.
Default value: 0

NO -

ConceptSuffix nvarchar
(200)

Empty for
default and
primary
concept; else 's.
lat.', 's. str.',
'sec.', 'sensu
Muell.', 'emend.'
, '(Auct.)' etc.
Default value: ''

YES -

ConceptNotes nvarchar
(500)

Notes on the
concept of the
name, e.g. incl.
forms with black
apothecia

YES -

RefURI varchar (255)

ReferenceURI:
Source
publication
where
synonymization
is published (not

YES -
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publication of
name!)

RefText nvarchar
(255)

Free text, esp.
where a RefURI
is missing.
Source
publication
where
synonymization
is published (not
publication of
name!)

YES -

RefDetail nvarchar
(255)

Esp. page
number on which
the
synonymization
is published

YES -

TypistsNotes nvarchar
(255)

An internal note
of the
responsible
person
concerning this
synonymization.
This information
is NOT included
in any report.

YES -

LogInsertedBy nvarchar (50)

Name of user
who first
entered (typed
or imported) the
data. This is the
operator (or
typist) name,
which may be
different from
the person
responsible.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when record
was first
entered (typed
or imported) into
this system.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user
who last
updated the
data. This is the
operator (or
typist) name,
which may be
different from
the person
responsible.

YES -
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Default value:
user_name()

LogUpdatedWhen smalldatetime

Date and time
when record
was last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifie
r

-
Default value:
newsequentialid(
)

YES -

Depending on:
 ProjectProxy
 TaxonNameProject

Table TaxonCommonName
TaxonCommonName contains the common names that are assigned to a
scientific name.

Column Data type Description Nullable Relation

NameID int

ID taxonomic
name. Refers to
the column
NameID of the
table TaxonName
(= foreign key).

NO Refers to table
TaxonName

CommonName nvarchar (220)
A common name
of the taxonomic
name

NO -

LanguageCode varchar (2)

The 2-letter code
of the language
of the common
name according
to ISO

NO
Refers to table
LanguageCode_E
num

CountryCode varchar (2)

The 2-letter code
of the country
where the
common name is
used according to
ISO ISO 3166-1 

NO
Refers to table
CountryCode_Enu
m

ReferenceTitle nvarchar (220)

The title of the
reference where
the common
name was
published

NO -

ReferenceURI varchar (255)

The URI of the
reference e.g. as
provided by the
module
DiversityReferenc
es

YES -
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ReferenceDetails nvarchar (500)

Esp. page number
on which the
common name is
published

YES -

SubjectContext nvarchar (500)

The context in
which the
common name is
used, e.g.
pharmacy, food

YES -

Transliteration nvarchar (255) - YES -

Notes nvarchar (MAX) Notes about the
common name

YES -

LogInsertedBy nvarchar (50)

Who inserted this
dataset
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

The time when
this dataset was
inserted
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Who was the last
to update this
dataset
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

The last time
when this
dataset was
updated
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 CountryCode_Enum
 LanguageCode_Enum
 TaxonName

Table TaxonGeography
TaxonGeography is containing the information about the geographic
distribution according to the protologue. 

Column Data type Description Nullable Relation

NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO Refers to table
TaxonName

PlaceURI varchar (255) URI (e.g. LSID) NO -
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within e.g. the
DiversityGazettee
r for a place
(which may have
several names)
as found in the
protologue

PlaceNameCache nvarchar (100) The name of the
place

NO -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 TaxonName

Table TaxonHierarchy
TaxonHierarchy contains information about the hierarchical position of the
taxa. For each project, a name may be referred to a single parent taxon.
The attribute "NameParentID" may, however, be Null, in which case
"HierarchyPositionIsUncertain" should be true.

Column Data type Description Nullable Relation

ProjectID int

Each project can
implement a
different
taxonomic

NO

Refers to table
ProjectProxy and
table
TaxonNameProjec
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hierarchy. Refers
to the common
project definition
in the
DiversityProjects
module.
Default value: 0

t

NameID int

Unique NameID
code of the
higher taxon.
Refers to the
NameID code of
LichenName (=
foreign key).

NO
Refers to table
TaxonNameProjec
t

IgnoreButKeepF
orReference tinyint

If true, the
record is ignored
for all purposes of
evaluation
(because
contradicted). It
is kept only to
maintain the
cited reference.
If no reference is
given, it may be
deleted instead.
Default value: 0

NO -

NameParentID int

Next higher taxon
(e.g. the family
or subfamily if
this taxon is a
genus)

YES -

HierarchyRefURI varchar (255)

Reference URI:
Source
publication where
the hierarchy is
published (not
publication of
name!) as stored
e.g. in
DiversityReferenc
es

YES -

HierarchyRefText nvarchar (255)

Free citation,
esp. where a
HierarchyRefURI
is missing. Source
publication where
the hierarchy is
published (not
publication of
name!)

YES -

HierarchyRefDetai
l nvarchar (255)

Esp. page number
on which the
hierarchy is
published

YES -

HierarchyPositionI
sUncertain bit If the position of

this taxon within YES -
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this taxonomic
group is
uncertain.
Default value: 0

HierarchyTypistsN
otes nvarchar (255)

An internal note
of the responsible
person
concerning this
hierarchy. This
information is
NOT included in
any report.

YES -

HierarchyListCach
e nvarchar (1000)

CALCULATED
FIELD: List of
higher taxa for
faster access:
"div.; class; ord.;
fam."

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when record was
first entered
(typed or
imported) into
this system.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when record was
last updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier -
Default value: YES -
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newsequentialid()

Depending on:
 ProjectProxy
 TaxonNameProject

Table TaxonName
TaxonName is the nomenclatural information. Most items are expected to
be undisputed nomenclatural facts. Some data items include editorial
opinion (nomenclatural status, but also the accepted spelling which may
involve orthographical or grammatical corrections as required by ICBN).
However, it is expected that within a project agreement can be achieved on
the information contained in TaxonName, i.e. collaborators can "correct"
information without consultation.

Column Data type Description Nullable Relation

NameID int

The ID of a name
in
DiversityTaxonNa
mes_Fungi
(primary key)

NO -

TaxonNameCache nvarchar (255)

A full unique
version of the
name. Generated
by the database,
not entered by
the user
(candidate key)

YES -

Version smallint

The version of a
name record
(revision number,
internally filled by
system)
Default value: (1)

YES -

BasedOnNameID int

The Basionym of
this name, resp.
the NameID of
the Basionym. A
name is a
Basionym, if
NameID =
BasionymID.

YES Refers to table
TaxonName

CreationType nvarchar (50)

E.g.: taxon based
on new type,
combination
based on a
previously publ.
name ('comb.
nov.'), new name
('nom.nov.')
introduced to
replace a
homonym (may
occur for

YES
Refers to table
TaxonNameCreati
onType_Enum
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genera!),
validation of
previously
invalidly publ.
taxon name
('ex'), or
unknown.

TaxonomicRank nvarchar (50)

Taxonomic rank
of the taxon
(var., subsp.,
species, genus,
family, order,
etc.). The rank
must be selected
from the
associated list of
ranks (=
TaxonomyRank)
Default value:
N'sp.'

NO
Refers to table
TaxonNameTaxon
omicRank_Enum

GenusOrSupragen
ericName nvarchar (200)

If rank is above
species: Name of
taxon above
species level
(currently
accepted
spelling). Includes
infrageneric taxon
names, genera,
families, etc.

NO -

SpeciesGenusNam
eID int

If rank is species
or below: NameID
of the Genus
name. Refers to
same table with
TaxonomicRank =
genus.

YES Refers to table
TaxonName

InfragenericEpith
et nvarchar (200)

If rank below
genus and above
species: Name of
infrageneric taxon
above species
level (currently
accepted
spelling). Includes
subgenus, series,
etc.

YES -

SpeciesEpithet nvarchar (100)

The species name
part of the
species name, for
example 'alba' in
'Abies alba'.

YES -

InfraspecificEpith
et nvarchar (100)

The epithet of
the infraspecific
entity

YES -

BasionymAuthors nvarchar (100) The authors of a
newly created YES -
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name. For all
taxonomic ranks,
only for 'comb.
nov.' or 'nom.
nov.': Author(s)
of the basionym
(will be displayed
in '()', do not
enter the
parentheses),
abbreviated
according to
authors standard

CombiningAuthors nvarchar (255)

The names of the
combining
authors if the
name is base on
another older
name (e.g.
combined into a
different genus)

YES -

PublishingAuthors nvarchar (255)

If the authors of
the taxon differ
from the authors
of the
publication: the
latter (...'in '
Publishing authors
... )

YES -

SanctioningAutho
r nvarchar (100)

Sanctioning is a
special
instrument
available for fungi
to allow the
starting date of
taxonomy to be
identical with
higher plants, but
preserve names
used by Fries
(Fr.) and Person
(Pers.)

YES -

NonNomenclatural
NameSuffix nvarchar (200)

A suffix for
concept names
not included in
any
nomenclatural
code. If present
fields for authors
and typification
must be empty
and
NomenclaturalCod
e set to 'not
under code'.

YES -

IsRecombination bit
True if the name
is a
recombination

NO -
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Default value: (0)

IsHybrid bit

If checked (or
'True'), the new
taxon is a hybrid
with or without a
hybrid epithet.
Default value: (0)

YES -

HybridNameID1 int

If IsHybrid is
checked (or
'True'): Name of
hybrid species 1.
Refers to NomID
code of publ.
TaxonomyName
(= foreign key).

YES Refers to table
TaxonName

HybridNameID2 int

If IsHybrid is
checked (or
'True'): Name of
hybrid species 2.
Refers to NomID
code of publ.
TaxonomyName
(= foreign key).

YES Refers to table
TaxonName

HybridNameID3 int

If IsHybrid is
checked (or
'True'): Name of
hybrid species 3.
Refers to NomID
code of publ.
TaxonomyName
(= foreign key).

YES Refers to table
TaxonName

HybridNameID4 int

If IsHybrid is
checked (or
'True'): Name of
hybrid species 4.
Refers to NomID
code of publ.
TaxonomyName
(= foreign key).

YES Refers to table
TaxonName

ReferenceTitle nvarchar (600)

The title of the
publication where
the name was
published. Note
this is only a
cached value
where
ReferenceURI is
present

YES -

ReferenceURI varchar (255)

URI (e.g. LSID) of
Reference,
referes to table
ReferenceTitle in
Database
DiversityReferenc
es: Source
publication where
name is published

YES -
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Volume nvarchar (20) The volume of
the journal

YES -

Issue nvarchar (255) The issue of the
literature

YES -

Pages nvarchar (50) The pages within
the literature

YES -

DetailLocation nvarchar (200)
Additional
information like
plates etc.

YES -

DayOfPubl tinyint
The day when
the name was
published

YES -

MonthOfPubl tinyint
The month when
the name was
published

YES -

YearOfPubl smallint
The year when
the name was
published

YES -

DateOfPublSupple
ment nvarchar (200)

Verbal or
additional date
information, e.g.
'end of summer
1985', 'first
quarter',
'1888-1892'

YES -

YearOnPubl smallint

The year cited on
the original paper
as year of
publication

YES -

DateOnPublSuppl
ement nvarchar (200)

Verbal or
additional date
information, e.g.
'end of summer
1985', 'first
quarter',
'1888-1892'

YES -

Protologue nvarchar (MAX)

Full text of the
protologue. If
protologue is
provided in Latin
and in another
language
languages, both
only the Latin or
several languages
may be stored
together.

YES -

ProtologueURI varchar (255)

URI of externally
available
Protologue
information
(scanned image,
full text from
external provider,
etc.)

YES -
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ProtologueResour
ceURI varchar (255)

The ResourceID
of an image of
the protologue as
stored in the
module
DiversityResource
s. Primary key of
table Resource in
the database
DiversityResource
s.(= Foreign key)

YES -

NameUsageRefere
nces nvarchar (255)

Indexing volumes
like Index of
Fungi or any
Name usage that
caused this name
to be added to
the database 

YES -

OriginalOrthograp
hy nvarchar (255)

The original
spelling of the
name

YES -

NomenclaturalCod
e nvarchar (50)

Code of
Nomenclature
under which this
taxon was
created:
'Bacteriology',
'Botany' (incl.
Mycology),
'Zoology',
'Biocode' (for
future use), 'Non
nomenclatural
name'. Default
value: 'Botany'

YES

Refers to table
TaxonNameNome
nclaturalCode_En
um

NomenclaturalSta
tus nvarchar (50)

Categories for
effective/valid/le
gitimate... esp.
'nom. illeg.', 'nom.
inval.', 'nom.
nudum', etc.

YES

Refers to table
TaxonNameNome
nclaturalStatus_E
num

NomenclaturalCo
mment nvarchar (MAX)

Comments on the
nomenclature.
e.g. 'according to
ICBN Art. 39.1'

YES -

Typification nvarchar (50)

The status of the
type specimen(s)
as written in the
protologue, e.g.
holotype

YES -

TypificationDetail
s nvarchar (255)

Details
concerning the
typification as
written in the
protologue, e.g. if
just parts of a
specimen were

YES -
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accepted as the
type

TypificationRefere
nceTitle nvarchar (255)

The title of the
publication where
the typification
was published.
Note this is only
a cached value
where
Typification-Liter
atureLink is
present

YES -

TypificationRefere
nceURI varchar (255)

URI (e.g. LSID) of
Reference, refers
to e.g
DiversityReferenc
es: Source
publication where
the typification is
published

YES -

TypificationNotes nvarchar (200) Notes concerning
the typification

YES -

TypeSubstrate nvarchar (255)

The substrate
the type was
growing on as
written in the
protologue

YES -

TypeLocality nvarchar (255)

The locality
where the type
was found as
written in the
protologue

YES -

TypeSpecimenNot
es nvarchar (200)

Notes about the
type specimen,
e.g. the
herbarium where
a type specimen
is located,
Collector,
collection
date/number,
etc.

YES -

AnamorphTeleom
orph nvarchar (255)

If the name is
related to a
anamorph or a
teleomorph as
written in the
protologue

YES -

TypistNotes nvarchar (200) Additional notes
and problems

YES -

RevisionLevel nvarchar (50)

The level of the
revision of the
taxonomic name,
e.g. 'unchecked',
'fully checked'

YES
Refers to table
TaxonNameRevisi
onLevel_Enum

IgnoreButKeepFor bit If true, the YES -
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Reference

record is ignored
for all purposes of
evaluation
(because
contradicted). It
is kept only to
maintain the
cited reference.
If no reference is
given, it may be
deleted instead.
Default value: (0)

DataWithholdingR
eason nvarchar (255)

If the dataset is
withhold, the
reason for
withholding the
data, otherwise
null

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when record was
first entered
(typed or
imported) into
this system.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when record was
last updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier -
Default value: YES -
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newsequentialid()

BasionymAuthors
Year int

The year when
the name was
published by the
authors of the
Basionym

YES -

Depending on:
 TaxonNameCreationType_Enum
 TaxonNameNomenclaturalCode_Enum
 TaxonNameNomenclaturalStatus_Enum
 TaxonNameRevisionLevel_Enum
 TaxonNameTaxonomicRank_Enum

Table TaxonNameExternalDatabase
TaxonNameExternalDatabase document the sources of the names.

Column Data type Description Nullable Relation

ExternalDataba
seID int

An ID to identify
an external data
collection of plant
names (primary
key, the ID has
no meaning
outside of the
DiversityWorkben
ch system)

NO -

ExternalDatabase
Name nvarchar (800)

The name of the
data collection
that has been
integrated or can
be linked to for
further analysis

NO -

ExternalDatabase
Version nvarchar (255)

The version of
this data
collection (either
official version
number, or dates
when the
collection was
integrated)

YES -

Rights nvarchar (500)

A description of
copyright
agreements or
permission to use
data from the
external database

YES -

ExternalDatabase
Authors nvarchar (200)

The persons or
institutions
responsible for
the external
database

YES -

ExternalDatabase nvarchar (300) The URI of the YES -
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URI
database provider
resp. the external
database

ExternalDatabase
Institution nvarchar (300)

The institution
responsible for
the external
database

YES -

InternalNotes nvarchar (1500)
Additional notes
concerning this
data collection

YES -

ExternalAttribute
_NameID nvarchar (255)

The table and
field name in the
external data
collection to
which
TaxonNameExtern
alID refers

YES -

PreferredSequenc
e tinyint

For selection in
e.g. picklists: of
several equal
names only the
name from the
source with the
lowest preferred
sequence will be
provided.

YES -

Disabled bit

If this source
should be
disabled for
selection of
names e.g. in
picklists

YES -

LogCreatedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogCreatedWhen datetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen datetime

Date and time
when the data
were last
updated.

YES -
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Default value:
getdate()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameExternalID
TaxonNameExternalID document the source of a name together with the ID
of the source.

Column Data type Description Nullable Relation

NameID int

The ID of a name
in
DiversityTaxonNa
mes (foreign key
+ part of primary
key: the name
string associated
with NameID may
occur in multiple
external
databases)

NO Refers to table
TaxonName

ExternalDataba
seID int

The ID of an
external
taxonomic data
collection as
defined in
TaxontNameExter
nalDatabase
(foreign key +
part of primary
key)

NO
Refers to table
TaxonNameExtern
alDatabase

ExternalNameURI varchar (255)

The URI (e.g. a
LSID) of the
external name as
defined in the
external database

YES -

LogCreatedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogCreatedWhen datetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50) Name of user who
last updated the YES -
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data.
Default value:
user_name()

LogUpdatedWhen datetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 TaxonName
 TaxonNameExternalDatabase

Table TaxonNameList
The table is containing the names listed in e.g. a checklist corresponding to
the project.

Column Data type Description Nullable Relation

NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO Refers to table
TaxonName

ProjectID int

Each project can
may contain one
taxon list. Refers
to the common
project definition
in the
DiversityProjects
module.

NO
Refers to table
TaxonNameListPr
ojectProxy

Notes nvarchar (MAX)
An note
concerning this
entry.

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -
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LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 TaxonName
 TaxonNameListProjectProxy

Table TaxonNameListAnalysis
Analysis values for list entries in the database, "Red list category: R",
"Time of observation: Sept. - Nov."

Column Data type Description Nullable Relation

NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO

Refers to table
TaxonNameList
and table
TaxonNameListRe
ference

ProjectID int

Each project can
may contain one
taxon list. Refers
to the common
project definition
in the
DiversityProjects
module.

NO

Refers to table
TaxonNameList
and table
TaxonNameListRe
ference

TaxonNameList
RefID int

Unique ID of the
reference within
the list, refers to
table
TaxonNameListRe
ference, part of
primary key
Default value:
(-1)

NO
Refers to table
TaxonNameListRe
ference

AnalysisID int ID of the analysis
(= foreign key) NO

Refers to table
TaxonNameListAn
alysisCategory

AnalysisValue nvarchar (MAX) The result of the
analysis

YES -

Notes nvarchar (MAX) Notes concerning
this analysis

YES -
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LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 TaxonNameList
 TaxonNameListAnalysisCategory
 TaxonNameListReference

Table TaxonNameListAnalysisCategory
Analysis types used within the database, e.g. "Red list category",
"Frequency"

Column Data type Description Nullable Relation

AnalysisID int ID of the analysis
(Primary key)

NO -

AnalysisParentID int

Analysis ID of the
parent analysis if
it belongs to a
certain type
documented in
this table

YES -

DisplayText nvarchar (50)

Name of the
analysis as e.g.
shown in user
interface

YES -

Description nvarchar (MAX) Description of the YES -
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analysis

AnalysisURI varchar (255)

URI referring to
an external
documentation of
the analysis

YES -

Notes nvarchar (MAX) Notes concerning
this analysis

YES -

LogCreatedWhen datetime

The time when
this dataset was
created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Who created this
dataset
Default value:
user_name()

YES -

LogUpdatedWhen datetime

The last time
when this
dataset was
updated
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Who was the last
to update this
dataset
Default value:
user_name()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

ReferenceTitle nvarchar (800)

The title of the
publication where
details about the
analysis are
published. Note
this is only a
cached value
where
ReferenceURI is
present

YES -

ReferenceURI varchar (400)

URI (e.g. LSID) of
Reference,
referes to table
ReferenceTitle in
module
DiversityReferenc
es: Source
publication where
details about the
analysis are
published

YES -

Table TaxonNameListAnalysisCategoryValue
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Value lists for analysis types with predefined values, e.g. "0, 1, 2, 3, ..." for
Red list category. Includes description etc. for the values in the list.

Column Data type Description Nullable Relation

AnalysisID int ID of the analysis
(Primary key) NO

Refers to table
TaxonNameListAn
alysisCategory

AnalysisValue nvarchar (255)
The categorized
value of the
analysis

NO -

Description nvarchar (500)

Description of
enumerated
object, displayed
in the user
interface

YES -

DisplayText nvarchar (50)

Short abbreviated
description of the
object, displayed
in the user
interface

YES -

DisplayOrder smallint

The order in
which the entries
are displayed.
The order may be
changed at any
time, but all
values must be
unique.

YES -

Notes nvarchar (500)

Internal
development
notes about
usage, definition,
etc. of an
enumerated
object

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime Date and time YES -
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when the data
were last
updated.
Default value:
getdate()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 TaxonNameListAnalysisCategory

Table TaxonNameListArea
The area defined for the whole taxon list

Column Data type Description Nullable Relation

ProjectID int

Each project can
have a different
opinion regarding
the parameters
defined for a list.
Refers to the
common project
definition in the
DiversityProjects
module.

NO
Refers to table
TaxonNameListPr
ojectProxy

PlaceURI varchar (255)

URI or identifier
for a place
(which may have
several names)
derived from e.g.
TDWG

NO -

PlaceNameCache nvarchar (255) The name of the
place

YES -

Notes nvarchar (MAX)
An note
concerning this
entry.

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50) Name of user who YES -
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last updated the
data.
Default value:
user_name()

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 TaxonNameListProjectProxy

Table TaxonNameListCollectionSpecimen
The collection specimens on which the taxon list is based

Column Data type Description Nullable Relation

NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO Refers to table
TaxonNameList

ProjectID int

ProjectID of the
taxon list. Foreign
key and part of
primary key. 

NO Refers to table
TaxonNameList

DisplayText varchar (255)

The name of the
collection
specimen as
shown e.g. in a
user interface.
Part of the
primary key

NO -

CollectionSpecime
nURI varchar (255)

URI of the
collection
specimen. May
refer to the
module
CollectionSpecime
n

YES -

Role nvarchar (50)

The role of the
specimen in
relation to the
taxon list (=
foreign key, see
table
TaxonNameListSp
ecimenRole_Enum
)

YES
Refers to table
TaxonNameListSp
ecimenRole_Enum
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Description nvarchar (MAX)
Description of the
collection
specimen

YES -

PlaceURI varchar (255)

URI or identifier
for a place
(which may have
several names)
derived from e.g.
TDWG

YES -

PlaceNameCache nvarchar (255) The name of the
place

YES -

Notes nvarchar (MAX)
Notes about the
collection
specimen

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 TaxonNameList
 TaxonNameListSpecimenRole_Enum

Table TaxonNameListDistribution
The geographical distrbution for the organisms within the taxon list.

Column Data type Description Nullable Relation
NameID int ID of the name. NO Refers to table
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Refers to the
NameID of
TaxonName (=
foreign key).

TaxonNameList
and table
TaxonNameListRe
ference

ProjectID int

Each project can
may contain one
taxon list. Refers
to the common
project definition
in the
DiversityProjects
module.

NO

Refers to table
TaxonNameList
and table
TaxonNameListRe
ference

TaxonNameList
RefID int

Unique ID of the
reference within
the list, refers to
table
TaxonNameListRe
ference, part of
primary key
Default value:
(-1)

NO
Refers to table
TaxonNameListRe
ference

PlaceURI varchar (255)

URI or identifier
for a place
(which may have
several names)
derived from e.g.
TDWG
Default value: ''

NO -

PlaceNameCach
e nvarchar (255)

The name of the
place
Default value: ''

NO -

Notes nvarchar (MAX) Notes concerning
this analysis

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime
Date and time
when the data
were last

YES -
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updated.
Default value:
getdate()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 TaxonNameList
 TaxonNameListReference

Table TaxonNameListImage
Media, e.g. images of the organisms within the taxon list

Column Data type Description Nullable Relation

NameID int

ID of the
accepted name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO Refers to table
TaxonNameList

ProjectID int

Each project can
may contain one
taxon list. Refers
to the common
project definition
in the
DiversityProjects
module.

NO Refers to table
TaxonNameList

URI varchar (255)
The complete URI
address of the
image. 

NO -

Description xml (MAX) Description of the
image

YES -

Notes nvarchar (MAX) Notes concerning
this analysis

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50) Name of user who
last updated the YES -
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data.
Default value:
user_name()

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 TaxonNameList

Table TaxonNameListProjectProxy
The taxon lists defined within the database. Links to the module
DiversityProject

Column Data type Description Nullable Relation

ProjectID int

ID of the Project,
Primary key. May
be related to
module
DiversityProjects

NO -

Project nvarchar (50)

The name of the
project. May be
related to module
DiversityProjets

NO -

ProjectURI varchar (255)

The URI of the
project, e.g. as
provided by the
module
DiversityProjects.

YES -

TaxonomicGroup nvarchar (50)

The taxonomic
group as used in
DiversityCollectio
n resp.
DiversityMobile

YES -

DisplayText nvarchar (50)

The text as
shown in a user
interface.
Corresponds to
ProjectTitle in
DiversityProjects.
Project

YES -

DefaultProjectID int

The ID of the
default project
where
informations
about e.g. the
synonymy are

YES -
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taken from

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameListReference
The reference where the taxon list resp. the name is published

Column Data type Description Nullable Relation

NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO Refers to table
TaxonNameList

ProjectID int

Each project can
may contain one
taxon list. Refers
to the common
project definition
in the
DiversityProjects
module.

NO Refers to table
TaxonNameList

TaxonNameList
RefID int

Unique ID of the
reference within
the list, part of
primary key

NO -

TaxonNameListRe
fText nvarchar (800)

Free text, esp.
where a
TaxonNameListRe
fURI is missing.
Source
publication where
distribution is
published (not
publication of
name!)

NO -

TaxonNameListRe
fURI varchar (255)

Reference URI:
Source
publication where
the distribution is
published (not
publication of
name!) as stored
e.g. in
DiversityReferenc
es

YES -

TaxonNameListRe
fDetail nvarchar (255)

Esp. page number
on which the
distribution is
published

YES -

ReferenceType nvarchar (50)
The type of the
reference, e.g. a
webpage

YES

Refers to table
TaxonNameListRe
ferenceType_Enu
m
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TaxonUsageConte
xt nvarchar (50)

The context of
the usage of the
taxonomic name
within the
reference, e.g.
ecology

YES -

Notes nvarchar (MAX)
An note
concerning this
entry.

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 TaxonNameList
 TaxonNameListReferenceType_Enum

Table TaxonNameProject
TaxonNameProject documents the projects of the names and provides
access to the data.

Column Data type Description Nullable Relation

NameID int

The ID of a name
in
DiversityTaxonNa
mes (foreign key
+ part of primary
key: the name

NO Refers to table
TaxonName
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may occur in
multiple projects)

ProjectID int

ID of the project.
Refers to the
common project
definition in the
DiversityProjects
module.
Default value: 0

NO Refers to table
ProjectProxy

LogInsertedWhen datetime

The time when
this dataset was
inserted
Default value:
getdate()

YES -

LogInsertedBy nvarchar (50)

Who inserted this
dataset
Default value:
user_name()

YES -

LogUpdatedWhen datetime

The last time
when this
dataset was
updated
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Who was the last
to update this
dataset
Default value:
user_name()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 ProjectProxy
 TaxonName

Table TaxonNameReference
References related to a taxonomic name

Column Data type Description Nullable Relation

NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO Refers to table
TaxonName

TaxonNameRefI
D int

Unique ID of the
reference, part of
primary key

NO -

TaxonNameRefTe
xt

nvarchar (800) The citation text
of the reference

NO -

TaxonNameRefURI varchar (500) Reference URI:
Link to the YES -
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source where the
publication as
stored e.g.
DiversityReferenc
es

TaxonNameRefDe
tail nvarchar (255)

Esp. page number
on which the
distribution is
published

YES -

ReferenceType nvarchar (50)
The type of the
reference, e.g. a
webpage

YES

Refers to table
TaxonNameListRe
ferenceType_Enu
m

Notes nvarchar (MAX)
An note
concerning this
entry.

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 TaxonName
 TaxonNameListReferenceType_Enum

Table TaxonNameResource
Resouces related to the taxonomic name
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Column Data type Description Nullable Relation

NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO
Refers to table
TaxonNameProjec
t

ProjectID int

ID of the project.
Refers to the
common project
definition in the
DiversityProjects
module.

NO
Refers to table
TaxonNameProjec
t

URI varchar (255)
The complete URI
address of the
resource. 

NO -

Description xml (MAX) Description of the
resource

YES -

Notes nvarchar (MAX)
A note
concerning this
entry.

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 TaxonNameProject
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Table TaxonNameTypification
The typification of a taxonomic name, e.g. where the type information of
the name was published 

Column Data type Description Nullable Relation

NameID int

The ID of a name
in
DiversityTaxonNa
mes_Fungi
(primary key)

NO Refers to table
TaxonName

TypificationRefe
renceTitle nvarchar (255)

The title of the
publication where
the typification
was published.
Note this is only
a cached value
where
Typification-Liter
atureLink is
present

NO -

TypificationRefere
nceURI varchar (255)

URI (e.g. LSID) of
Reference, refers
to e.g
DiversityReferenc
es: Source
publication where
the typification is
published

YES -

Typification nvarchar (500)

The status of the
type specimen(s)
as written in the
protologue, e.g.
holotype

YES -

TypificationDetail
s nvarchar (255)

Details
concerning the
typification as
written in the
protologue, e.g. if
just parts of a
specimen were
accepted as the
type

YES -

TypificationNotes nvarchar (200) Notes concerning
the typification

YES -

TypeSubstrate nvarchar (255)

The substrate
the type was
growing on as
written in the
protologue

YES -

TypeLocality nvarchar (255)

The locality
where the type
was found as
written in the
protologue

YES -

TypeSpecimenNot nvarchar (500) Notes about the YES -
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es

type specimen,
e.g. the
herbarium where
a type specimen
is located,
Collector,
collection
date/number,
etc.

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when record was
first entered
(typed or
imported) into
this system.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when record was
last updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 TaxonName

Table TaxonSynonymy
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TaxonSynonymy contains names, which are synonym to other names. Here
a single name may be a synonym of multiple accepted names ("pro parte
synonym"). The "pro parte" or corresponding sensu information is captured
in the "ConceptSuffix" attribute, which is part of the primary key.

Column Data type Description Nullable Relation

ProjectID int

Each project can
have a different
opinion regarding
synonmy. Refers
to the common
project definition
in the
DiversityProjects
module.
Default value: (0)

NO

Refers to table
ProjectProxy and
table
TaxonNameProjec
t

NameID int

ID of the
synonymized
name. Refers to
the NameID of
TaxonName (=
foreign key).

NO
Refers to table
TaxonNameProjec
t

SynNameID int

The ID of the
synonym to
which this name
has been
assigned to.
Refers to the
NameID of
TaxonName (=
foreign key).

NO
Refers to table
TaxonNameProjec
t

IgnoreButKeepF
orReference tinyint

If true, the
record is ignored
for all purposes of
evaluation
(because
contradicted). It
is kept only to
maintain the
cited reference.
If no reference is
given, it may be
deleted instead.
Default value: (0)

NO -

ConceptSuffix nvarchar (200)

Empty for default
and primary
concept; else 's.
lat.', 's. str.',
'sec.', 'sensu
Muell.', 'emend.' ,
'(Auct.)' etc.
Default value: ''

YES -

ConceptNotes nvarchar (500)

Notes on the
concept of the
name, e.g. incl.
forms with black
apothecia

YES -
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SynRefURI varchar (255)

Reference URI:
Source
publication where
synonymization is
published (not
publication of
name!) as stored
e.g. in
DiversityReferenc
es

YES -

SynRefText nvarchar (255)

Free text, esp.
where a
SynRefURI is
missing. Source
publication where
synonymization is
published (not
publication of
name!)

YES -

SynRefDetail nvarchar (255)

Esp. page number
on which the
synonymization is
published

YES -

SynTypistsNotes nvarchar (255)

An internal note
of the responsible
person
concerning this
synonymization.
This information
is NOT included in
any report.

YES -

SynType nvarchar (50)

Type of the
synonymization,
e.g. 'heterotypic',
'homotypic'
Default value:
'unknown'

NO

Refers to table
TaxonNameSynon
ymisationType_En
um

SynIsUncertain bit

If the
synoymization is
uncertain.
Corresponding to
=? for
heterotypic
synonyms and ? if
the type of the
synonymisation is
unknown.
Homotypic
synonyms can
not be uncertain.
Default value: (0)

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data. This is the
operator (or

YES -
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typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

LogInsertedWhen smalldatetime

Date and time
when record was
first entered
(typed or
imported) into
this system.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when record was
last updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Depending on:
 ProjectProxy
 TaxonNameProject
 TaxonNameSynonymisationType_Enum
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Installation
To run DiversityTaxonNames, you need the database and the client. The image below gives an
overview of the software you need. 

Database

To run the database you need MS SQL-Server 2005 or later.

Client

The client is based on the .Net framework from Microsoft. If not already present, you have to
install:

Microsoft .NET Framework Version 3.5 

(see http://www.microsoft.com/downloads/ for the latest versions)

Copy all files extracted from DiversityTaxonNames.zip into one directory. 

Database
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For the installation of a local database see the section Installation of the database.
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Login administration
To administrate the logins on the database server, their permissions and roles respectively as
well as access to projects choose Administration - Database - Logins ... from the menu. A
window will open as shown below. 

 

Statistics

To see the activity of a login click on the button. A window will open as shown below listing
all databases and tables together with the timespan (From - To) and the number of data sets
where any activity of the current login has been found.

To see the current activity on the server click on the button. A window as shown below will
open listing all user related processes on the server.
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Creation of login

To create a new login click on the button. A window will open as shown below.

Here you can enter the name of the new login, the password and the information about the
user which will be stored in a DiversityAgents database. You may either create a new entry in
this database or select an existing one: Click on the button to search for a name in the
database (see below).
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Copy a login

To copy a login including all permissions etc. into a new login, select the original login in the
list and click on the button. 

 

Edit a login

To edit the access for a login on the server select the login in the list. If a login should be
disabled , uncheck the enabled checkbox (see below).

All databases on the server will be listed with the current database showing a yellow
background. The databases where the login has no access will be listed in gray while the
databases accessible for a login are black. 
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Access of a login to a database

To allow the access to a database select the database from the list and choose database as
shown below. 

 

Roles of a login in a database

Use the > and < buttons to add or remove roles for the login in the database (see below). 

 

Projects for a login in a database

Depending on the database you can edit the list of projects accessible for a login (see below).
Projects are related to the module DiversityProjects. To get additional information about a
project select it in the the list and click on the button.  
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To load additional projects click on the Load projects button. A window will open as shown
below. Projects already in the database will be listed in green, missing projects in red (see
below). Check all projects you need in your database and click the Start download button.

 

Overview for a login

If you see an overview of all permissions and project for a login, click on the button. A
window a shown below will open. It lists all modules and their databases, the roles
and projects for a login.  
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To copy the permissions and projects of the current login to another login, select the login
where the settings should be copied to from the list at the base of the window and click on
the button to copy the settings for all databases or the button to copy the settings of
the selected database into this login.  

 

Overview for a database 

If you see an overview of all user and roles in a database, click on the button. A window a
shown below will open. It lists all user and roles in the database.  
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To remove a user, select it in the list and click on the button.  

 

Correction of logins

If you select one of the databases, at the base a button may appear. This indicates, that
there are windows logins listed where the name of the login does not match the logins of the
server. This may happen if e.g. a database was moved from one server to another. To correct
this, click on the button. A list of deviating logins will be shown, that can be corrected
automatically. 

If logins with the same name but different server are found, one of them has to be deleted to
make the correction possible. You will get a list where you can select those that should be
removed. 
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Select the duplicate logins that should be removed and click OK. 
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Database - access
If you start the client for the first time, you will not be connected to any database, indicated
by the icon in the left upper corner as shown below.

If you are not connected to a database this will be indicated by the icon of the

connection button. If you are connected to a database this is indicated by the icon   . To
access any database, you must specify the server where the database is located. For the
configuration of this connection choose Connection, Database... from the menu or click on

the  button.

Database name, IP-address and Port

A dialog will open, where you can specify the name or IP-adress and port number of the
server and the authentication mode. You can either choose Windows authentication (see left
image below) or SQL-Server authentication (see middle image below).
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The standard port number for SQL-Server is 1433 and will be set as a default. If the database
server is configured using a port different from that port, you must give the port number in

the field Port. Click on the button to connect to the server. If the
connection informations are valid, you can choose a database from the server from the
combobox at the base of the form (see right image above). To restart the connecting process

click on the button. 

If you access a database for the first time you will be asked to consent to the storage and
processing of your personal data (see below) according to the General Data Protection
Regulation. Without your consent the access is not possible.
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Version
For information about the version of the client application choose Help, Info...

The current version in the example above is 2.1.

the numbers following are buildnumber and revision.
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Feedback
For any wishes or problems with the database that you want to send to the administrator you
can do this under the menu Help - Feedback. Move to the window you want to be
included in your feedback and click ALT - PRINT to create a screenshot. Then open the
feedback form under the menue Help - Feedback ... . A form as shown below will open. To

enter the screenshot, click on the button. The description is entered in the field
Description. In the field Topic enter the topic of your feedback (will appear in response
e-mail). The Priority can either be empty or set to 3 levels: urgent, as soon as possible and
nice to have. If necessary, enter a date in the field ToDo until when you would like to have
the task described in you feedback be solved. 

 

To send the feedback click on the button.  
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Export - overview
There are several options to export data.

 Export of hierarchy and synonymy
 Export of taxon list information
 Export via list view
 Export via export wizard
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Export wizard 
The export wizard provides a possiblity to export the data selected in the main form. The data
are exported as tab separated text file. The export and may include transformations of the
data as well as informations provided by linked modules and webservices. Choose Data -
Export - Export wizard - Export Taxon... from the menu. For a short introduction see
the tutorial. 

 

Adding tables 

There are the following ways to add tables: 

 One parallel table
 Several parallel tables according to selected data
 Dependent table

All options will include the depending tables as defined for the default table. The option for
several tables will add as many tables as there are found in the data. 

If you added parallel tables, you should set the sequence of the datasets within these tables:
For the colums that should be used for sorting the data, set the ordering sequence to a value
> 0 and choose if the ordering sequence should be ascending or descending .

 

Adding related values 

Certain columns in the database may provide informations linked to another table or a
module resp. webservice . Click on the button to add a linked value. 

 

Adding and editing file columns 

To add colums to the exported file, use the buttons. In the textbox at the top of the file
column, you can change the header for the column. To change the position of a file column
use the resp. button. To fuse a column with the previous column, click in the gray bar on
the left side of the column that will change to for fused columns. To remove a file column,
use the button. Pre- and postfixes for the columns can directly be entered in the
corresponding fields. To apply transformations on the data click on the button.

 

Filtering data 

To filter the data you have 2 options. Either filter the content of the whole table using the 
table filter or select a certain row in the data using the row filter.

      Filter the content of the whole table = from the whole table only datasets
matching the filter will be exported

     Filter the content of the table in a certain file column = if the content matches
the filter the data will be exported in the corresponding file column

To set a filter just click on the corresponding buttons and enter the filter you need. To
remember you of the set filter, the background of the button will become red.
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Test 

To test the export choose the Test tab, set the number of lines that should be included in
the test and click on the Test export button. To inspect the result in a separate window,
click on the button.

 

Export 

To export your data to a file, choose the Export tab. If you want to store the file in
different place use the button to choose the directory and edit the name of the file if
necessary. Check the include a schema option if you want to save a schema together
with your export. To start the export, click on the Export data   button. To open the
exported file, use the button.

 

Schema 

To handle the settings of your export, choose the Schema tab. To load a predefined
schema, click on the button. To reset the settings to the default, click on the 
button. To save the current schema click on the button. With the button you can
inspect the schema in a separate window. 

 

 

 

 

  

 

Page 65



Export wizard - transformation 

The exported data may be transformed e.g. to adapt them to a format demanded by the user.
Click on the button to open a window as shown below. 

Here you can enter 6 types of transformation that should be applied to your data. Cut out
parts,  Translate contents from the file, RegEx apply regular expressions or Replace
text and apply Calculations or Filters on the data from the file. All transformations will be
applied in the sequence they had been entered. Finally, if a prefix and/or a postfix are defined,
these will be added after the transformation. To remove a transformation, select it and click
on the button. 

 

Cut 

With the cucut transformation you can restrict the data taken from the file to a part of the
text in the file. This is done by splitters and the position after splitting. In the example below,
the month of a date should be extracted from the information. To achieve this, the splitter '.'
is added and then the position set to 2. You can change the direction of the sequence with
the button Seq starting at the first position and starting at the last position. Click on the
button Test the transformation to see the result of your transformation. 
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Translate 

The trtranslate transformation translates values from the file into values entered by the
user. In the example above, the values of the month should be translated from roman into
numeric notation. To do this click on the button to add a translation transformation (see
below). To list all different values present in the data, click on the button. A list as shown
below will be created. You may as well use the and buttons to add or remove values from
the list or the button to clear the list. Then enter the translations as shown below. Use the

save button to save entries and the Test the transformation button to see the result.  

Page 67



To load a predefined list for the transformation use the b button. A window as shown below
will open. Choose the Encoding of the data in your translation source and indicate if the 
First line contains column definition. Click OK to use the values from the file for the
translation. 

 

Regular expression 

The transformation using regular expressions will transform the values according to the
entered Regular expression and Replace by v values. For more details please see
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documentations about regular expressions. 

 

Replacement 

The replacement transformation replaces any text in the data by a text specified by the user.
In the example shown below, the text "." is replaced by "-".  

 

Calculation  

The calculation transformation performs a calculation on numeric value, dependent on an
optional condition. In the example below, 2 calculations were applied to convert 2-digit values
into 4 digit years. 
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Filter  

The filter transformation compares the values from the data with a value entered by the user.
As a result you can either Export content intofont> file or Export fixed value. To
select another column that should be compared, click on the button and choose a column
from the file in the window that will open. If the column that should be compared is not the
column of the transformation, the number of the column will be shown instead of the 
symbol. To add further filter conditions use the button. For the combination of the
conditions you can choose among AND and OR.  
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Export wizard - tutorial
This tutorial demonstrates the export of a small sample of data from the database. 

Choosing the data 

 In the main form, select the data that should be exported (only the data displayed in the
query results are exported). 

Exporting the data 

Choose Data -> Export -> Wizard -> Export taxa ... from the menu. 

A window as shown below will open where the available tables for export are listed in the
upper left area. To show the data colums of a table, select this table in the list. 
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Adding columns 

In this example, we want to add the higher hierarchy, starting with the order. Select the 
Order from the list as shown below. 
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In the Columns area appearing in the area on the right click on the button to add the Order
to the columns list.
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This is repeated for the Family and the Genus (see below). 
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In the taxon table choose the column GenusOrSupragenericName to add teh genus to te
exported (see below). 
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To avoid that the column name GenusOrSupragenericName appears in our export, we change
the name to Genus (see below). 
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The same is repeated for the species, authors, common names and synonyms (see below). 
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Testing 

After all columns that should be exported and their transformations are defined, we start Test
export to see the result as shown below. 
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Click on the button to open the result in a separate window (see below). 

 

Export 

To export the data change to the tab and click on the Export data button. The result is
shown in the textbox below and stored in the specified file (see below).  
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Together with the exported data, a schema is stored, containing all settings of the export.
This schema may be reused for subsequent exports of the same type (see below). 
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Export hierarchy and synonymy
To export the taxonomy, including the hierarchy and the synonymy, select the corresponding
taxon, choose Data -> Export -> Export hierarchy and synonymy... from the menu. 

To see the whole hierarchy, select the desired node in the hierarchy tree and click on the 
button besides the hierarchy. 

A window as shown below will open

 

The data you in the export will depend upon the taxon you selected in the main form. So if
e.g. you want to export the names within a genus, select the genus in the main form.

If you want to include the synonyms, check Restrict to accepted names and Show

synonyms and click on the button (see below).
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 If you start the export without any schema file, you will get the data strutured as xml (see
below).

 

To format the data, specify the schema file containing your preferred format as shown below. 
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You can export the data including all higher taxa (see above) or starting with the taxon for
which you selected the export (see below). mao format the data, specify the schema file
containing your preferred format as shown below.

 

 To export only the higher taxa, you can restrict the lowest rank to e.g. the genus as shown
below. 
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If you choose the option Summary, the numbers of the differnet hierarchical levels will be
listed at the bottom of the report (see image below)
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Export list
To export lists, including information about the distribution or the synonymy, choose Data ->
Export -> Export taxon list ... from the menu. A window as shown below will open, where
you can choose the taxonomic list and the project where the synonomy of the taxa is
documented. 

 

Choose a Schema file and the options for your export. Than click on the Create the taxon list
to start the export. The resulting html file (see below) will be named according to the choosen
schema file.
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If you miss to choose a schema file, the original XML file will be shown (see below). To
convert this into a html file, choose a schema file and click the button.
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Import
To import taxonomic names you have two options. Either use an import taxonomic names
including evaluation of names according to codes like ICBN and automatic splitting of the
names or a generic import wizard providing the additional possibilty to import synonyms and
hierarchies.

Page 95



Import taxonomic names
To import taxonomic names, choose Data → Import taxonomic names ... from the menu.
A window as shown below will open. Choose the encoding of your datasource, that means if
your datasource was encoded with ASCII or a unicode format. To ensure a correct import of
special signs please provide resp. convert your data in one of the available formats. You must
choose a Project, in which your data should be imported. You may choose a Taxon list and
a Datasource and if the names should be imported as accepted. 

If there are additional columns in the source file (separated by tab) you may add these unsing
the Add column button (see below) in the sequence as found in the source file. The
additional columns will be included in the analysis of the data as shown below. To remove a
column use the button. 

To start the analysis of the data, just click on the button to open the source file. If you
want to re-analyse a file with new settings, click on the   button. To send a feedback, use
the button. If the names should be linked to higher taxa, check the Link taxa to genera if
present option. The names can be compared with existing names within the current project
or the whole database. If you compare the names with the whole database, you can insert a
link for the current project for identical names that are missing in the project.

 

Your names will be listed as shown in the image above. If an error (e.g. special signs
converted with the wrong encoding)
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or a similar name

 

or an identical name

 

is found these will be marked as shown above and the names of your list will not be imported
unless you check the according field (second column - Import name). If you changed one of
the options, click on the Requery button to see the result. 

To start the import, click on the according button Start import.
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Import wizard for tab separated lists
With this import routine, you can import data from text files (as tab-separated lists) into the
database. Choose Data -> ImportWizard and then the type of data that should be
imported, e.g. Import Taxa ... from the menu. A window as shown below will open that will
lead you through the import of the data. The window is separated in 3 areas. On the left side,
you see a list of possible data related import steps according to the type of data you choosed
for the import. On the right side you see the list of currently selected import steps. In the
middle part the details of the selected import steps are shown. 

 

Choosing the File 

As a first step, choose the File from where the data should be imported. The currently
supported format is tab-separated text. Then choose the Encoding of the file, e.g. Unicode.
The Start line and End line will automatically be set according to your data. You may change
these to restrict the data lines that should be imported. The not imported parts in the file are
indicated as shown below with a gray background. If the First line contains the column
definition this line will not be imported as well. If your data contains e.g. date information
where notations differ between countries (e.g. 31.4.2013 - 4.31.2013), choose the Language
/ Country to ensure a correct interpretation of your data. Finally you can select a prepared
Schema (see chapter Schema below) for the import. 

Page 98



 

Choosing the data ranges

In the selection list on the left side of the window (see below) all possible import steps for the
data are listed according to the type of data you want to import.

The import of certain tables can be paralleled. To add parallels click on the button (see
below). To remove parallels, use the button. Only selected ranges will appear in the list of
the steps on the right (see below).

To import informations of logging columns like who created and changed the data, click on 
button in the header line. This will include a additional substeps for every step containing the
logging columns (see below). If you do not import these data, they will be automatically filled
by default values like the current time and user.
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Attaching data 

You can either import your data as new data or Attach them to data in the database.
Select the import step Attachment from the list. All tables that are selected and contain
columns at which you can attach data are listed (see below). Either choose the first option 
Import as new data or one of the columns the attachment columns offered like SeriesCode in
the table Series in the example below. 

If you select a column for attachment, this column will be marked with a blue background (see
below and chapter Table data).

 

Merging data 

You can either import your data as new data or Merge them with data in the database.
Select the import step Merge from the list. For every table you can choose between 
Insert, Merge, Update and Attach (see below). 

The Insert option will import the data from the file independent of existing data in the
database. 

The Merge option will compare the data from the file with those in the database according
to the Key columns (see below). If no matching data are found in the database, the data
from the file will be imported, otherwise the data will be updated.. 

The Update option will compare the data from the file with those in the database according
to the Key columns. Only matching data found in the database will be updated. 

The Attach option will compare the data from the file with those in the database according
to the Key columns. The found data will not be changed, but used as a reference data in
depending tables.  
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Table data 

To set the source for the columns in the file, select the step of a table listed underneath the 
Merge step. All columns available for importing data will be listed in the central part of the

window. In the example shown below, the first column is used to attach the new data to data
in the database.

A reminder in the header line will show you what actions are still needed to import the data
into the table:

 Please select at least one column   = No column has been selected so far. 
 Please select at least one decisive column   = If data will be imported depends on the

content of decisive colums, so at least one must be selected.
 Please select the position in the file   = The position in the file must be given if the

data for a column should be taken from the file. 
 Please select at least one column for comparision   = For all merge types other than

insert columns for comparision with data in the database are needed.
 From file or For all   = For every you have to decide whether the data are taken from

the file or a value is entered for all
 Please select a value from the list   = You have to select a value from the provided

list 
 Please enter a value   = You have to enter a value used for all datasets 

The handling of the columns in described in the chapter columns. 

 

Testing 

To test if all requirements for the import are met use the Testing step. You can use a
certain line in the file for you test and then click on the Test data in line: button. If there are
still unmet requirements, these will be listed in a window as shown below. 
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If finally all requirements are met, the testing function will try to write the data into the
database and display any errors that occurred as shown below. All datasets marked with a red
background, produced some error.  

To see the list of all errors, double click in the error list window in the header line (see below).
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If finally no errors are left, your data are ready for import. The colors in the table nodes in the
tree indicate the handling of the datasets: INSERT, MERGE, UPDATE, No difference. Attach,
No data. The colors of the table colums indicate whether a colum is decisive , a key column

or an attachment column .  

If you suspect, that the import file contains data allready present in the database, you may
test this an extract only the missing lines in a new file. Choose the attachment column (see
chapter Attaching data) and click on the button Check for allready present data. The data
allready present in the database will be marked red (see below). Click on the button Save
missing data a text file to store the data not present in the database in a new file for the
import. Please keep in mind, that this comparision will be performed without any
transformations of the data, that means the data in the file must match exactly those in the
database.  

 

Import 

With the last step you can finally start to import the data into the database. If you want to
repeat the import with the same settings and data of the same structure, you can save a
schema of the current settings (see below). 

Schedule for import of tab-separated text files into DiversityTaxonNames
Target within DiversityTaxonNames: TaxonName

Schedule version: 1 Database version: 02.05.14

Lines:3 - 5 First line contains column
definition: 

?

Encoding:ANSI Language:US
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Tables

TaxonName (TaxonName) 
Merge handling: Merge

Column in table ? Ke
y

Co
py

Pr
e

Po
st

File
pos.

Transformations Value Source Table

NameID 2027929 Interface

TaxonomicRank fam. Interface

GenusOrSupragenericNam
e

? ? 0 File

NomenclaturalCode 3 Interface

TaxonNameProject (TaxonNameProject) 
Parent: TaxonName
Merge handling: Merge

Column in table ? Ke
y

Co
py

Pr
e

Po
st

File
pos.

Transformations Value Source Table

NameID ParentTable

ProjectID ? ? 58 Interface

TaxonAcceptedName_1 (TaxonAcceptedName) 
Parent: TaxonNameProject
Merge handling: Insert

Column in table ? Ke
y

Co
py

Pr
e

Po
st

File
pos.

Transformations Value Source Table

ProjectID ParentTable

NameID ParentTable

 Lines that could not be imported will be marked with a red background while imported lines
are marked green (see below).
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If you want to save lines that produce errors during the import in a separate file, use the
Save failed lines option. The protocol of the import will contain all settings acording to the
used schema and an overview containing the number of inserted, updated, unchanged and
failed lines (see below).
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Import wizard - Columns 

If the content of a file should be imported into a certain column of a table, mark it with the 
checkbox. 

Decisive columns 

The import depends on the data found in the file where certain columns can be choosed as
decisive. Only those lines will be imported where data are found in any of these decisive
columns. To mark a column as decisive, click on the icon at the beginning of the line (see
below).

In the example shown below, the file  4 columns were marked as decisive. Therefore only the
two lines containing content in this column will be imported. 

 

Key columns 

For the options Merge, Update and Attach the import compares the data from the
file with those already present in the database. This comparision is done via key columns.
To make a column a key column, click on the icon at the beginning of the line. You can
define as many key columns as you need to ensure a valid comparision of the data.

 

Source 

The data imported into the database can either be taken From file or the same value that
you enter into the window or select from a list can be used For all datasets. If you choose
the From file option, a window as shown below will pop up. Just click in the column where the
data for the column should be taken from and click OK (see below).
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If you choose the For all option, you can either enter text, select a value from a list or use
a checkbox for YES or NO.

For the column NameID in the taxon import you can either provide this ID directly provided
you can ensure these IDs do not exsist in the database or you let the database  Generate
a new value.

For the ID columns for the import of Synonyms or the Hierarchy you can either provide
the ID directly or let the program search for the ID according to the taxonomic name in the
database. 

 

Transformation 

The data imported may be transformed e.g. to adapt them to a format demanded by the
database. For further details please see the chapter Transformation. 

 

Copy 

If data in the source file are missing in subsequent lines as shown below, 

you can use the Copy line option to fill in missing data as shown below where the blue
values are copied into empty fields during the import. Click on the button to ensure that
missing values are filled in from previous lines. 
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Prefix and Postfix 

In addition to the transformation of the values from the file, you may add a pre- and a postfix.
These will be added after the transfromation of the text. Double-click in the field to see or
edit the content. The pre- and a postfix values will only be used, if the file contains data for
the current position. 

 

Column selection 

If for any reason, a column that should take its content from the imported file misses the
position of the file or you want to change the position click on the button. In case a
position ist present, this button will show the number of the column. A window as shown
below will pop up where you can select and change the position in the file. 

 

Multi column 

The content of a column can be composed from the content of several columns in the file. To
add additional file columns, click on the button. A window as shown below will pop up,
showing you the column selected so far, where the sequence is indicated in the header line.
The first column is marked with a blue background while the added columns are marked with a
green background (see below). 

Page 109



To remove a added column, use the button (see below). 

 

Information 

The button opens a window displaying the informations about the column. For certain
datatypes additional options are included (see Pre- and Postfix). 
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Import wizard - transformation 

The data imported may be transformed e.g. to adapt them to a format demanded by the
database. Click on the button to open a window as shown below. 

Here you can enter 4 types of transformation that should be applied to your data. Cut out
parts,  Translate contents from the file, RegEx apply regular expressions or Replace text
in the data from the file. All transformations will be applied in the sequence they had been
entered. Finally, if a prefix and/or a postfix are defined, these will be added after the
transformation. To remove a transformation, select it and click on the button. 

 

Cut 

With the cut transformation you can restrict the data taken from the file to a part of the
text in the file. This is done by splitters and the position after splitting. In the example below,
the month of a date should be extracted from the information. To achieve this, the splitter '.'
is added and than the position set to 2. You can change the direction of the sequence with
the button Seq starting at the first position and starting at the last position. Click on the
button Test the transformation to see the result of your transformation. 
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Translate 

The translate transformation translates values from the file into values entered by the user.
In the example above, the values of the month cut out from the date string should be
translated from roman into numeric notation. To do this click on the button to add a
translation transformation (see below). To list all different values present in the data, click on
the button. A list as shown below will be created. You may as well use the and buttons
to add or remove values from the list or the button to clear the list. Than enter the
translations as shown below. Use the save button to save entries and the Test the
transformation button to see the result.  
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To load a predefined list for the transformation use the button. A window as shown below
will open. Choose the encoding of the data in you translation source, if the first line contains
the column definition and click on the  button to open a file. Click OK to use the values from
the file for the translation. 

 

Regular expression 

The transformation using regular expressions will transform the values according to the
entered Regular expression and Replace by vales. For more details please see
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documentations about regular expressions. 

Some examples:

Regular
expression Replace by Effect Input Output

\w+  Replaces any digit or
letter text, 12+3 and () ,+()

[^()]  
Replaces anything
besides the specified
content

text, 12+3 and () ()

 

Replacement 

The replacement transformation replaces any text in the data by a text specified by the user.
In the example shown below, the text "." is replaced by "-".  
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Calculation  

The calculation transformation performs a calculation on numeric value, dependent on an
optional condition. In the example below, 2 calculations were applied to convert 2-digit values
into 4 digit years. 

 

Filter  

Page 115



The filter transformation compares the values from the file with a value entered by the user.
As a result you can either Import content of column in file or Import a fixed value. To
select another column that should be compared, click on the button and choose a column
from the file in the window that will open. If the column that should be compared is not the
column of the transformation, the number of the column will be shown instead of the 
symbol. To add further filter conditions use the button. For the combination of the
conditions you can choose among AND and OR.  
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Import wizard - tutorial
This tutorial demostrates the import of a small file into the database. The example file is
included in the software.  At the end of this tutorial you will have imported several datasets
and practiced most of the possibilities provided by the import wizard. The import is done in
several steps to demonstrate the functionality of the wizard. Please keep in mind, that this
tutorial will only work as shown, if the names contained in the file are not already present in
the database.

 

 Step1 - Import of the taxa 

Choose Data -> Import Wizard -> import Taxa ... from the menu. A window as shown
here below will open. Click on the button to open the file ImportTutorial.txt shipped with
this application. In addition to the preselected steps, select the step Common names to
import the common name contained in the file. In the Merging step leave all tables as 
Insert (see below).  

In the Taxon step, set the first column NameID to Generate new value. Then select the
additional columns as shown below. For the column TaxonomicRank choose For all and select
species from the list. For the column NomenclaturalCode choose For all and select Botany
(incl. Mycology) from the list. All columns besides NameID, NomenclaturalCode and
TaxonomicRank are set on From file and the colums are set as shown in the image below.
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The column CombiningAuthors needs a transformation. To add this, click on the button.
Enter a translation as shown below where the value NULL is translated to nothing.

Select a translation transformation (click on the button) and press the button to enter a
translation (see below).
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Press Test the transformation to visualize how the data would be imported (see below).

To allow the import of this table, choose the 2 columns GenusOrSupragenericName and
SpeciesEpithet as Decisive columns (see below).  
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In the step Common name choose the column CommonName as Decisive column and 
From file (column 6) for and For all for the other 3 columns as shown in the image below. 
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In the step Project select For all and the project DiversityWorkbench from the list and
select this column as Decisive column.  

In the step Accepted name no further action is needed.  

In the step Testing check if you missed any settings described above. A test should return
a result as shown below.  

Finally   Import the taxa. If no errors occur, the import should return a result as shown
below.  
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 Proceeded with Steps 2 & 3 - Import of the higher taxa 
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Import wizard - tutorial
 Step2 - Import of the higher taxa - family 

To import the hierarchy, the higher taxa must be imported first. Choose the same file as in the
first step for the import. The data for the higher taxa are not unique in the file. Therefore in
the Merging step, choose Merge for all tables (see below). 

In the Taxon step, set the first column NameID to Generate new value. Then select the
column TaxonomicRank and choose For all and select family from the list. Finally select the
column GenusOrSupragenericName, set it as Decisive columns, set it on From file and the
column 1 as source (see below).

In the step Project select For all and the project DiversityWorkbench from the list and
select this column as Decisive column.  

In the step Accepted name no futher action is needed.  

Finally Import the taxa. If no errors occur, the import should return a result as shown
below. Only the green lines are imported. The yellow lines are found identical to the already
imported data and are therefore not imported.  
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 Step3 - Import of the higher taxa - order 

Next we Import the order. Follow the steps as described for the family above with the
difference that now for TaxonomicRank we select order from the list and choose column 0 as
source for the column GenusOrSupragenericName taxa. If no errors occur, the import should
return a result as shown below. Only the green lines are imported. The yellow lines are found
identical to the already imported data and are therefore not imported (see below).  
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 Proceeded with Step 4 - Import of the hierachycal
relation between families and the order 
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Import wizard - tutorial
 

 Step 4 - Import of the hierachycal relation between
species and families 

To import the hierarchical relation between the taxa choose Data -> Import Wizard -> 
Import Hierarchy ... from the menu. For every hierarchical rank, you have to import the
relations between the taxa. We start with the relations from the species to the family (the
genus as intermediate rank between species and family is omitted in this example). 

As described in the previous steps, open the file ImportTutorial.txt shipped with this
application. In the Merging step leave the table on Insert (see below). 

In the Hierachy step, select the columns  Taxon (Name or ID) and Higher taxon (Name or
ID) as Decisive columns (see below). 

For the column ProjectID, select For all as shown below and select the project of your
choice from the list (e.g. DiversityWorkbench if available). 

As the file does not contain the IDs of the name, we let the program determine the ID on
basis of the name. To enable the program to detect the ID we need to provide the whole
name from the data in the file. We start with the column Taxon (Name or ID). As first step,
click on the button to set the source for the genus, the first part of the taxonomic name. A
window as shown below will open. Mark the column as shown below an click on the OK
button. 
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Next we need the species epithet as second part of the names. Click on the button to add
another column. A window as shown below will open where where the previous selected
column for the Genus is marked with 1. We select the column containing the species epithet
(see below) and click OK. 

Now we need the authors as last part of the names. Again click on the button to add a
column and select the source as shown below. 

As shown below, enter a space in the Postfix for the first 2 columns. 
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If combining authors do exist for a name, the authors of the basionym are set in brackets. To
ensure the correct build-up of the name, we need to add a transformation. Click on the 
button to enter the a filter as shown below where an opening bracket ( is inserted in
dependence of the content of the column of the combining authors. 

To set the column for the filter, click on the button and choose the column containing the
combining authors as shown below. 
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The final Transformation should look like shown below. 

After adding the optional opening bracket we add the authors of the basionym. Click on the 
button and select the column as shown below. 

As final step for the authors of the basionym we need the optional closing bracket. Click on
the button and select the column as shown above. For the new colum enter another filter

transformation as shown below. To set the column for the filter, click on the button as
described for the opening bracket. 
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Finally we need the combining authors, provided they do exist. Click on the button and
select the column containing the combining authors. As these are missing for some names we
have to add a transformation where the content NULL is translated into nothing. Click on
the button to add a transformation and in the window that will open, click on the button
to add a  translation (see below). 

To add a value that should be translated, click on the button and type NULL into the
window as shown below. 

The final transformation should look like shown in the image below. 
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The final build-up for the Taxon should look like in the image below. 

Now we enter the higher taxon, in this example the family. Click on the button and choose
the column containing the family as shown below. 
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Now the Hierarchy step is finished and should look like shown below. 

In the Testing steps use the test for a check if you missed any settings described above.
The result of the test should appear like shown below. 
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Finally Import the data according to your settings. The result of the import should appear
like shown below. 

 

 Proceeded with Step 5 - Import of the hierachycal
relation between families and the order 
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Import wizard - tutorial
 

 Step 5 - Import of the hierachycal relation between
families and the order 

After the relations between the species and the families are imported we proceed with the
hierarchical relation between families and the order. Choose Data -> Import Wizard -> 
Import Hierarchy ... from the menu.  

As described in the previous steps, open the file ImportTutorial.txt shipped with this
application. In the Merging step set the table on Merge (see below). 

As described in the previous step, select the project of your choice and set the columns
Taxon and Higher Taxon to From file.  

Click on the button to select the source for the family (see below). 

... and the orders as shown below. 
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Additionally you must select these columns as Key columns, used to compare the data from
the file with the content in the database (see below). 

A final test before importing the data turns positive (see below). 

Now we are ready to import the relation into the database. For every family this relation will
be imported only once (see below). 
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As a last step, search for the highest taxon "Russulales" in the hierarchy in the main from and
click on the button set hierarchy (see below) . 
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After the hierarchy for the Russulales is set, all imported name will show the complete
hierarchy as shown in the example below. 
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 Proceeded with Step 6 - Import of the synonyms 
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Import wizard - tutorial
 

 Step 6 - Import of the synonyms 

To import the synonyms, choose Data -> Import Wizard -> import Synonyms ... from
the menu. A window as shown below will open.  

In the Taxon step choose From file for the Genus and select the colums Synonym1 as
shown below. 

To get only the genus from the name in the source, add a transformation for the column. Click
on the button and in the window as shown below add a cutting transformation. Enter a
space as Splitter. A Test of the transformation should produce the result as shown below. 
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Next select the SpeciesEpithet and again From file (see below). 

Select the same column as for the genus (see below). 

... and as for the genus add a cutting transformation with a space as splitter but this time
set the Position to 2 (see below). 
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Choose the columns for the genus and the epithet as Decisive columns (see below). Next
we turn to the authors of the synonym. Select the From file for BasionymAuthors ... 

And choose the SynonymAut1 Column as shown below. 
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To cut out the basionym authors we add a cut transformation as shown below. Enter ) as
splitter. 

Next we add a  Replace transformation to get rid of the leeding bracket (see below). 
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Now we turn to the combining authors ... 

Again we add a cut transformation with ) as Splitter, but 2 as Position (see below).  
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The window now should look like below.  

As a last entry in the taxon step we choose Botany for the Nomenclatural Code (see below). 
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In the Project step select For all, choose the project where you want to import the data
and set this column as Decisive column. 

In the Synonymy step select From file for the accepted name. Now we must combine
the accepted name from the entries in the file to match the entry in the database.

Select the Genus column for the first part of the accepted name (see below). 

Click on the button to add another column and choose the Species column as shown below
as source. 
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For both columns enter a space into the Postfix (see below). 

Next we add the authors. For the basionym authors we need to add brackets if combining
authors do exist. Select the Author column ...   

... and add a filter transformation (see below). Here we choose Import fixed value and
enter ( as a value. As condition we choose that the colum of the combining autors should not
contain the string NULL.  
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To complete this transformation click on the button and select the column containing the
combining authors (see below). 

To add the basionym authors themselves, click on the  button and choose the corresponding
source as shown below.

Next we need the closing bracket for the basionym authors. As before we click on the button
and for the new entered columns we add a filter transformation as shown below. Enter ) as
fixed value and as before select that the source for the combining authors should be unequal
to NULL. 

Finally we get the values for the combining authors. Add another column and select the
corresponding column in the source (see below). 
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To remove the NULL value, we add a  translation transformation. As only string that should be
translated, we click on the  button and enter NULL (see below). 

Now the translation should look like below. 

As final action in the Synonym step we choose the column for the Acc.name as 
Decisive column (see below). 
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A final Testing will detect any missed settings. 

After the final test is passed, we can Import the data as shown below. The schema will
automatically be created and is available for subsequent imports.  
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Menu
Overview of the menu in DiversityTaxonNames

Connection

     Database ...
Choose one of the databases available on the server. Only
those databases will be listed to which the user has access
permission

    Module connections ...
Edit the connections to the other modules within the
Diversity Workbench.

     Transfer previous settings
Transfer the settings for IP-Address and port of the server,
name of the database, login etc. of a previous version of
the client to the current version.

     Quit
Quit the application and stop all processes started by the
application

Query
     Show query Show resp. hide the query area
     Show ignored data If data that were set on ignore should be visible

     Predefined queries
This dialog will only appear if predefined queries are
available. The submenu then lists the names for the
predefined queries

Table views

   View taxa in table ... Show the taxa in a spreadsheet

   Edit taxa in table ... Edit the taxa in a spreadsheet

Administration

   Analysis categories ... Administration of the analysis categories used within the
taxon lists

   Data sources ... Administration of the data sources of the taxonomic names

   Database  
       Documentation ... Documentation functions for the database

        Rename database Rename the current database

        Set published address Setting the address published for links by other modules

       Logins ... Administration of the logins and user
       Maintenance ... Maintenace functions within the DiversityTaxonNames

       Database tools Tools to create and change objects in the database

   Image description template ... Administration of the description template for the images
within a project

   List User ... Administration of the logins and user
   Predefined queries ... Administration of the predifined queries

   Syonchronize projects ... Administration of the projects
      Taxon lists ... Administration of the taxon lists

      Withholdling data ... Administration of the withholding reasons of names
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References
  Edit references ... Edit the local list of the references
  Edit journals ... Edit the local list of the journals

Data
   Export hierarchy and synonymy
...

Export the taxonomic names with their hierachy and
synonoymy

   Export taxon lists ... Export the taxon lists as XML / HTML files

   Import taxonomic names ... Import taxonomic names from text files

   Backup database ... Backup of the whole database

   Export as CSV (bcp) Export data of the whole database as csv files

Help

   Manual Opens the online manual

   Feedback ... Opens a window for sending feedback

   Feedback history ... Opens a window for browsing former feedback

     Statistics Show the statistics within a project
     Info Show the version and corresponding information
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Manual

The online manual DiversityTaxonNames.chm must be placed in your application folder,
together with the application DiversityTaxonNames.exe and the library
DiversityWorkbench.dll.To get information to any topic in the application DiversityTaxonNames
and open this manual, just click on the field you need information about and press F1.
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Archive 
Create archive 

The data related to a project can be exported into an archive. Choose Data - Archive - 
Create archive... from the menu. A window as shown below will open. 

Select the project you want to create an archive of and click on the Find the data button.
The program will scan the data for all informations related to the project and include them in
the archive as shown below. 
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The data related with the project will be imported into temporary tables to allow you to
inspect them in advance of the creation of the archive (use the buttons to see the data).
To create the archive, click on the Create the archive button. 

A directory will be created containing a XML file for every table and a protocol file containing a
summary of the archiving event.  

 

Reset database 

Before you restore an archive, please make sure that the data from the archive do not
interfere with the data in the database. In order to avoid problems you should clean the
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database from any user data. To clear the database from any user data, choose  Data - 
Archive - Reset database... from the menu. A window as shown below will open listing all
tables and the number of data within these tables. Click on the Reset database  button to
remove any of these data including any data in the log tables. 

 

Restore archive 

To restore an archive choose Data - Archive - Restore archive... from the menu. A
window as shown below will open listing the tables in the database. To restore an archive
click on the Choose archive directory button and select the directory containing the
archive files. Next click on the Read data button to import the data from the XML files into
temporary tables.
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With a click on the buttons you can inspect the content of the temporary tables. Finally
click on the Restore the archiv button.
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Maintenance
Hierarchy

In DiversityTaxonNames the hierarchy of a taxon is represented by the relation to a parent
taxon, e.g. Rosa canina -> Rosa. To enable the search within the whole hierarchy is cached
as a text string e.g. ( ... Rosales | Rosaceae | Rosa | ... ). After changes in the hierarchy this
string should be updated. Choose Administration -> Maintenance ... from the menu. A
window as shown below will open. You can either update the hierarchy cache for a single
project or the whole database. For the first option, choose the project that should be
updated and click the start button to perform the update. For the whole database just click
on the button. 

 

Projects and lists

In DiversityTaxonNames names of projects and list are cached according to the original data in
DiversityProjects. If the original names are changed, you can use the maintenance to
synchronise the local names with the original data (see image below). Click on the Load
projects resp. Load lists button to find all entries with names different from the originals. To
update the names in the local cache, click on the Start update button. 

 

Duplicates

If for any reason there are duplicates of taxa in DiversityTaxonNames these can be listed in
the Duplicates part. Click no the Search for duplicates button to list all duplicates
independent of the project as shown in the image below. To edit the detected duplicates,
click on the Open duplicates in main form button. 
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In the main form any duplicate will be marked by the appearence of a button as shown
below. Click on the button to change between the duplicates of a name. 
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Query
The application provides two main options to search for a taxonomic name. The results of any
search will be listed in the listbox on the left side of the main form (selected names). To
choose one of the found names just click on it.

Direct query

For a direct search of a name enter the search conditions in the fields provided in the "Query
conditions". You may alter the visible field as described under options . You can change this

arrangement using the    button to place the query options on the left side of the item
list.

The available operators for text values are = for exactly equal entries or ~ for similar entries.
Here you can choose "%" (any sequence of characters) and "_" (one character) as wildcards.
For more details of SQL-wildcards refer to the manual or SQL-Server.

If you omit to select a project and the synonymy for a name is defined in several projects,
you will get an entry in the resultset for every project as shown in the example below.

 

If you want to hide the Query conditions area, click on the button. The Query conditions

area will be hidden. To show it again click on the button. To change the displayed fields for

searching specimen click on the  button to change the query options . 

After you have specified your search phrase click on . This starts the search for any name
matching your phrase. If you want to add the searched name to those allready listed then
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click on . If the list of items is longer than your maximal number of returned items you can

browse the next items with the button. To move back to the previous block of items click

on the button. If you want to remove entries from the selected list, choose them and

click on the button. This will not delete the data from the database, but remove them
from your query result.

Within the query options you have several possibilities to specify your search restriction. Use
the drop down button to change between the operator. The available operators are shown in
the table below. 

Operator Meaning Example
Text

∼ search for an entry like ... Pinus s[iy]lvestris % (you can use 
wildcards)

= search for an entry exactly equal to ... Pinus silvestris L.

≠ search for an entry not like ... Pinus s[iy]lvestris % (you can use 
wildcards)

∅ search for an entry where a value is missing ...

• search for an entry where a value is present ...
- search for an entry between ... and ... 2000 - 2005
| search within a list of entries, separated by "|" or return 2000 | 2003 | 2005
Numeric
= search for an entry exactly equal to ... 2006
< search for an entry lower than ... 2006
> search for an entry bigger than ... 2006
- search for an entry between ... and ... 2000 - 2005

∅ search for an entry where a value is missing ...

• search for an entry where a value is present ...

| search within a list of entries, separated by "|", space, tab or
return 2000 | 2003 | 2005

Date
= search for an entry exactly equal to ... 20.3.2006
< search for an entry lower than ... 20.3.2006
> search for an entry bigger than ... 20.3.2006
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∅ search for an entry where the date is missing ...

• search for an entry where the date is present and complete ...
Hierachy
= search for an entry exactly equal to ... M-Fungi
≠ search for an entry that is not equal to ... M-Fungi

∅ search for missing entry ...

• search for present entry ...
Δ search including childs in a hierarchy ... M-Fungi
XML
/ Search for entries containing a given XML node settings
¬ Search for entries not containing a given XML node settings

∅ search for missing entry ...

• search for present entry ...

For yes/no fields you will get an checkbox with 3 options: = yes, = no, = undefined 

If you want to indicate accepted names in the result list, choose View, indicate accepted
names

Predefined queries

If prefined queries are available for a database, you can choose these querries under Query,
Predefined queries. The command for the retrieval will be shown in the Query conditions
area. Click on the button to start the predefined query.

 

Query results

To indicate the synonymy of the names in the query results check the menu Query, Indicate
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synonymy. The synonymy of the names will then be indicated as shown in the image below.

 

An accepted name will not be indented. Synonyms and names with no synonymy defined will
be indented. The syononyms will be marked with a sign to indicate the synonymy as described
in the list below.

Sign in list meaning

not indented Accepted name
   indented, no sign No synonymy defined
≡ homotypic synonym

= heterotypic synonym

– unknown synonymy

≈ duplicate, isonym or orthographic variant
p.p. pro parte resp. more than one synonymy defined
• final revision
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Options
The maximal number of items shown in a query result can be set in the window for the query
options. The default value is set to 100. If you have a fast connection to your database or
need to see more or less results, you may change this value to any number you like.
To change the displayed search fields click on the  button. This opens a form where you
can select and deselect the fields shown for searching specimens. You might also change the
maximum number of items that will be shown in the result list. 

The limit for the creation of drop down lists is by default set to 1000. If you connect to a
database, the programm will create drop down list based on the entries in the database to
ease the entry in the query. For slow connections you may set this to lower value to speed
up the start of the program. If you set the value to 0 no drop down lists will be created.

 

In the top of the form you can specify the maximal number of resultset that will be retrieved
in one query. In the lower part you can select the search fields.
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Wildcards in SQL
There are 4 different possibilities for wildcards in SQL:

%     any string consisting of no, one or many characters, e.g. Pinus % will find anything like
Pinus, Pinus sylvestris, Pinus strobus etc.

_      a single character, e.g. Pinus s_lvestris will find Pinus sylvestris and Pinus silvestris etc.

[]      any character out of a given range like [abcde] or [a-e], e.g. Pinus s[iy]lvestris will find
Pinus sylvestris and Pinus silvestris.

[̂ ]   any character not in a given range like [̂ abcde] or [̂ a-e], e.g. Pinus s[̂ i]lvestris will
find Pinus sylvestris but not Pinus silvestris
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Main form
The header of the main form allways shows you, with which database you are working, the
version of the client, the database server and your login. The area for the data entry is
devided into 2 main parts. In the upper part you enter nomenclatural information and facts, in
the lower part taxonomic opinions of the editors (see topic database for further informations).

 

To see the descriptions for the fields of the database, simply move your mouse over it. A
tooltip will appear with an explanation as shown in the example below.

Where you have to choose names from lists, type the beginning of the name in the field and

then click on the drop down button . This will start a query in the database and list the
result in the combobox.

If a field is to small for reading its content double-click on it. A form will open, where you can
edit the text.
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List view
To see the data in a spreadsheet, choose View → List view ... from the menu. A window
will open where all names from the query will be listed. 

Customize visibility of fields

To change the selection of the visible fields, click on the Column visibility button. A
window as shown below will open, where you can change the visibility of the columns. 

 

Customize sequence

To change the sequence of the columns, just use your mouse to drag the columns to the
position of your choice. 

Sorting of the data

To sort the data in the grid just click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
That means that if you change a value in the sorting column the changed dataset will be
placed at the new position according to its new value. The sorting of a column will be
indicated with an arrow for the direction of the sorting (up or down).   

Change to data in main form

To change to a name in the main form, click on the , use the button.  

Formatting the grid

To adapt the width of the columns or the height of the rows either drag the border with the
mouse, double click the border to get the optimal size for one column or respectively or click
on the button for an optimal height of the rows or the button for an optimal width of the
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columns. 

Exporting data

After setting the form according to your preferences, you can export the data with a click on
the button. 
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Edit the taxa in a list
To edit the taxa in a spreadsheet, choose View → Edit taxa in list ... from the menu. A
window will open where all names from the query will be listed. 

Customize visibility of fields

To change the selection of the visible fields, click on the Column visibility button. A
window as shown below will open, where you can change the visibility of the columns. 

 

Customize sequence

To change the sequence of the columns, just use your mouse to drag the columns to the
position of your choice. 

Sorting of the data

To sort the data in the grid just click in the header of the column which you want to use as
sorting column. The sorting sequence will be kept even if you change values in this column.
That means that if you change a value in the sorting column the changed dataset will be
placed at the new position according to its new value. The sorting of a column will be
indicated with an arrow for the direction of the sorting (up or down).   

Change to data in main form

To change to a name in the main form, click on the , use the button.  

Formatting the grid

To adapt the width of the columns or the height of the rows either drag the border with the
mouse, double click the border to get the optimal size for one column or respectively or click
on the button for an optimal height of the rows or the button for an optimal width of the
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columns. 
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Data

To save the changes in a dataset click on the button.

To undo the changes in a dataset click the button. This will recover the original data
unless the changes had been saved or changes were done in the synonymy.

To create a new entry in the database, click on the  button above the search
result listbox. A window will open where you can add additional projects to the list in which
the new name shoul be included (see below). By default only your current project will be
selected. 

 

Leave only those projects the new name is related to. Click OK to create a entry with the
name "New Taxon".

To copy a taxon, choose it from the list and click on the button . As with the creation of
a new dataset you can insert the copy of a name into other projects (see above).

To delete a dataset click on the button .
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Taxonomic Name
The header shows the name, the ID and the version of the name - these data can not be
edited. If a dataset should be ignored, check the checkbox "Ignore". In the last field you can
enter a revision level for the dataset. If you want to inspect the history of a dataset click on

the  button.

 

Data concering the taxonomic name including the authors are entered in the corresponding
area (see image below). 

 

Depending on the taxonomic rank, the form will show only the fields available for this rank. 

If the genus is linked to an entry in the database, the field for the genus will change as shown

here and the program will not allow you to edit the name. To edit the genus of the
name, click the button to release the link to the genus. The list of genera is restricted to
the project you selected. If a hierarchy is availble for the selected genus the hierarchy will be
automatically inserted for the current name. 

If the name is a hybrid , check the checkbox "Is hybrid" to get access to the fields for
hybridization.
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Authors
For names according to an official code (ICBN) the authors of the name should be given. 

 

To edit the authors using standard abbreviation list click on the Button. This will open the
form for editing the authors.

 

here you add (click on the button) and remove (click on the button) authors
according to the standard list. You can choose the standards for the abbreviation from the
provided lists.

For names not following an official code authors should not be given. Instead, include a
descriptive phrase in the field Non nomenclatural name suffix.

To edit the selected list of the authors click on the Edit author list button. 
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Nomenclature
DiversityTaxonNames was developed to follow, for the most part, the International Code of
Botanical Names (ICBN). Other codes like the code for names in zoology have not yet
been taken into account. Information corresponding the nomenclature are entered in the
provided fields as shown below.
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Taxonomic reference and protologue
Details about the protologue are entered in the area Taxonomic reference / Protologue

 

To enter a website for the protologue either enter the link in the field or click on the button 

to start a query. This will open simple browser where you can search the URL for the
protologue as shown below.
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Typification
Details about the type can be entered in the area "Typification".

 

The navigate through the data use the , , and button. To add a new typification use
the button, to delete the current dataset, use the button. 
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Hybrids
As for the time being a definite rule for the creation of a valid taxonomic name on the basis of
the parent names is not available. Therefore the name is build from the genus and all the rest
placed in the field for the epithet. 

Some examples for hybrids are:   

 

Asplenium x alternifolium Wulfen.
Coeloglossum x Dactylorhiza Coeloglossum viride x Dactylorhiza majalis subsp.
praetermissa
Ononis repens subsp. procurrens x spinosa subsp. spinosa
Salix (caprea x viminalis) x (purpurea x viminalis)
Salix alba var. vitellina x babylonica x matsudana
Symphoricarpos albus var. laevigatus x microphyllus x orbiculatus

As soon as a rule is available the name can be generated from the parent names that are
entered as described below. 

If a taxon is a hybrid, check the checkbox to open the part for the entry for the
parents of the hybrid. You can determine up to 4 parents for a hybrid as shown in the figure
below

 

Page 178



Synonymy
Basionym

The name on which the choosen name is based on should be entered in the "Based on:" field. 

 

A name can be either an accepted name or a synonym to an accepted name. If nothing was
specified so far, two buttons are visible:

choose one of these to make the choosen name to either an accepted name or a synonym.

Synonym

If the name is a synonym, the area for the synonymy will appear as shown in the images

    

A name in most cases is synonym to one name but may sometimes be synonym to several
names (e.g. pro parte). If you want to keep information of the synonymy you can set it to
ignore (see chapter Ignored data for further details). 

Delete a synonym

To delete a synonym, choose it in the list and click on the delete button .

 

Accepted Name

If the name is accepted, the form will show data related to accepted names
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You can indicate accepted names in the search result list (in the menu choose View,
indicate accepted names)

 

Conflict (Name declared a synonym and a basionym)

If by any chance (e.g. after import of synonymy relations from a foreign source) a name
happens to be a synonym and an accepted name at the same time this is regarded as an error
and will be shown as in the image below. 

The data for the synonym are shown on the right side with blue labels, while the data for the
accepted name are shown on the left with green labels. To correct this error you can either
remove or ignore (see chapter Ignored data for further details) the assignement as a synonym
or an accepted name.

 

Overview
In the area Synonymy overview you see the accepted name for the name you chose and a
list of all the synonyms to this name. The sign  ≡ in front of a name following the accepted
name means that this and the following names are homotypic synonyms to the accepted
name. Groups of hetereotypic names start with a "=" in front of the first entry. If present, the
first entry in each group is the basionym of this group. Names with unclear relation to the
accepted name are preceeded by a "-". To change to one of the names in the list, choose it
in the list and click on the search button . The overview can be shown either as a list,

corresponding to lists in publications or as a tree view. Use the  and  button to change
between these views. In the tree view the current name is marked with a  yellow  background
as shown below. The scrutiny of the search can be adapted by changing the number in the

tool bar . As standard it is set on 3, but can be changed to values between 0 (just the
current name) to 9. The higher the scrutiny the more thoroughly the search for synonyms will
be performed and the longer it will take.
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Explanation of the example above: 
accepted name Ceratiomyxa fruticulosa (O.F.Müll) T.Macbr. 
basionym  ≡ Byssus fruticulosa O.F.Müll.

homotypic synonym Famintzinia fruticulosa (O.F.Müll.) Lado

heterotypic synonym and basionym  = Tremella hydnoidea Jacq.
heterotypic synonym Ceratium hydnoideum (Jacq.) Alb.& Schwein.

Editor

For a direct editing of synonymy list click on the button  . The list with the selected
names and the synonymy overview will get a yellow background (see image). 

Now you can add synonyms to the synonymy list by simply dragging them from the selected
names list on a name in the synonymy tree view. If you drag the name on the accepted name,
it will become a homotypic synonym of the accepted name. If you drag it on a heterotypic
synonym, it will become a heterotypic synonym of the accepted name and get the same
basionym as the name you dragged it upon. If this name has no basionym, the dragged name
will become a homotypic name of the name you dragged it upon. If you want to create a new
heterotypic synonym or a synonym with unknown relation to the accepted name, drag the
name in the empty space of the tree view.

If you want to correct the synonymy you can drag the names within the synonymy overview
either on another name to create a homotypic synonym or into the free space underneath the
names to create a heterotypic synonym to the accepted name.

To remove a name from the lists of synonyms, choose it in the tree view and click on the 
button.
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Isonyms, duplicates and orthographic variants

Some names are a variant spelled exactly as another name but with deviating citation of the
author(s). These might be a name with wrong citation of the publishing or recombining
author(s) or an isonym sensu ICBN. To change the type of the synonymy to an isonym choose
the taxon and change the syn. type e.g. to "isonym". In the synonymy overview list the
isonyms, duplicates etc. are indicated by square brackets "[duplicate: ... ]".

Ignored datasets

If it should happen, that a dataset that is ignored is included in a synonymy in the form that
another name is referring to this ignored name, the system will not be able to generate the
synonymy properly. To detect ignored datasets in the synonymy choose "Query -> Show
ignored data" from the menu (see chapter Ignored data for further details). Ignored dataset
will than be shown with red letters in the synonymy as shown below.

The information about the synonymy is related to opinions of the editors and are allways
restricted to a certain project. The data of the synonymy are stored in table TaxonSynonymy.
The data of the accepted names are stored in table TaxonAcceptedName.
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Hierarchy
The taxonomy for the choosen name is depicted in the area Hierarchy. If the taxonomy has
not been specified a button (set hierarchy) will be visible 

click on it to insert a dataset for the hierarchy of this taxon.

To choose a higher taxon you first have to specify the taxonomic rank of the choosen name

  

and type at least 2 characters of the higher taxon in the 'Superior taxon:' field. 

Click on the drop down button to get the list of taxa above the rank of the name for which
you want to set the hierarchy. The hierarchy will then be shown in the tree view (see below).
The taxa below the current taxon will be displayed in gray.

 

The first line shows the taxon or taxonomic group superior to the choosen taxon. To directly
access the database entry of a higher taxon, choose this taxon in the hierarchy tree and click

on . The button  will delete this entry. As an alternative to delete the entry for the
hierarchy, you may set it on Ignore to keep the information but exclude it from the creation of
a hierarchical tree (see chapter Ignored data for further details). To get an overview of the

whole hierarchy click on the button . You get an overview for the whole taxonomy
including the current taxon as shown below.
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In the taxon tree the main taxonomic groups are indicated with icons (S = species, G = Genus,
F = Family, O = Order, C = Class, K = Kingdom). To change the position of a taxon within the
hierarchy, use the drag & drop function of the tree. 

To enable a search within the hierarchy, please use the maintenace function to update the
hierachy cache. The hierarchy is stored in one string, so to search for e.g. all members of e.g.
a certain familiy e.g. Rosaceae, please use the ~ operator and a leading wildcard in your
search string e.g. "% Rosaceae" or "* Rosaceae".

The information about the hierarchy is related to opinions of the editors and are allways
restricted to a certain project. The data of the hierarchy are stored in table TaxonHierarchy.
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Common names
A name can have several common names. These are entered in the section Common names
. To add or delete a common name use the  and  buttons.

The data of the common names are stored in table TaxonCommonName.
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Ignored data
To remove data from the creation of the hierarchy, the synonymy etc. on one hand and not
to delete them but to keep the information, use the Ignore option. All data set to 
Ignore are no longer involved in the normal queries, but kept to ensure e.g. links from other
modules. To display ignored data, select Query - Show ignored data in the menu. 

Synonyms

In the example below, a synonym was set on ignore. 

 

If it should happen, that a ignored name is included in a synonymy and a name within the
synonymy is referring to this ignored name, the system will not be able to generate the
synonymy properly. Ignored names will than be shown with red letters in the synonymy
overview as shown below.

 

Accepted names

In the example below, the entry for an accepted name was set to ignore, now showing this
information side by side with the current setting of the name as a synonym.
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If several entries for an accepted name exist, a list will appear at the left side as shown below
where to top entry (0) is the valid entry, while all other entries (> 0) are set to ignore (see
below).

 

Hierarchy

As with the accepted names, ignored data will be listed as shown below in a list where to top
entry (0) is the valid entry, while all other entries (> 0) are set to ignore. 
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Geography
Details about the type can be entered in the area "Geography". 

The geographical distribution of the type specimen according to the protologue can be typed
in the field Locality of the area Typification. In the area Geography names according to a
standard can be entered as a list as shown above. To remove an entry from the list click on
the button. To add an entry click on the button. A form will open where you can choose
geographical places from the module DiversityGazetteer. To open the link to the module, click
on the  button and search for the region as described in the chapter Module related entry. 

 

The data of the geography are stored in table TaxonGeography.
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Resources
Resources related to a taxon can be added in the area "Resources". Use the (add), 
(remove) and (save) buttons to handle the resources. 

For every project, a description template can be defined for the resources. Choose 
Adminstration - Image description template ... from the menu to define the template.
To add a description for a resource, use the button  . A window will open where you can
edit the description for a resource. 

The data of the resources are stored in table TaxonNameResource.
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References
References related to a taxon can be added in the area "References". Use the (add) and
the (remove) buttons to handle the references. 

The data of the references are stored in table TaxonNameReference.
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Lists for taxonomic names 
With DiversityTaxonNames you can document list for taxonomic names like e.g. checklists. The
taxon lists may refers to a project defined in DiversityProjects (see Administration - User ...
in the menu). To edit the taxon lists choose Administration → Taxon lists ... from the menu.
A window as shown below will open, where you can enter, edit or delete taxon lists. The
administrative functions are only available for administrators.  

 

For the detailed documentation of the Taxon lists please use DiversityProjects. To load
projects into the list, click on the Download projects from DiversityProjects button (see
above). A window as shown below will open. If several Databases for DiversityProjects are
available on your server you have to choose one of these. The projects available in the
DiversityProjects database will be listed as shown below where those already present are 
checked and green, while missing projects are red. Check those projects you need as lists and
click the Start download button.  
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For access to the related data choose the tab Taxon lists (see below).  

 

To enter a new list, click on the button. This will open a window where you can choose
from the available taxon lists. Choose the list in which you want to include your name and
click OK. 

Area

The geographical area can be definded for a single name (via Distribution) or for the whole
taxon list. The entries refer to the World geographical scheme for recoding plant distributions.
To enter the geographic area for the whole list, click on the button. A form will open where
you can choose geographical places from the module DiversityGazetteer. To open the link to
the module, click on the button and search for the region as described in the chapter
Module related entry. 
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If you need a certain region not provided in the list, just type the name of the region and click
OK. The new region will be listed directly underneath the list (see below). 

 

 

References

For every name in a taxon list, you can enter the references where the informations for the
list are derived from. To add a reference, select the list for which you want to add a
reference and click on the button. The entry for the reference will appear underneath the
taxon as shown below. To edit this entry, select it in the hierarchy and use the contols
underneath the tree. You may link the reference to an external source like DiversityReferences
or one of the provided webservices.

If you want to transfer the informations of a reference together with depending analysis
and distribution entries to another name, select the reference in the tree und click on the

button. As a result you can use the button to insert these informations at a different
place. 

 

Analysis

To edit the analysis used within the database, choose Administration - Analysis categories
... from the menu. A window will open, where you can define new types of analysis or edit
existing ones. The analysis tyes may be organized within hierarchies as shown below. For
categorized analysis you can define value lists, from which the user can choose. 
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For a name within a list, you can enter an analysis can either directly for the name or a
reference linked to this name. Select the name or the reference in the tree and click on the 
button to enter a new analysis. Depending on the definition of the analysis To edit the
analysis used within the database, select it in the tree and use the area below the the tree.
Depending on the definition of the analysis (see above) the values are either typed or
selected from a list. 

Distribution
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For every entry in a taxon list, you can document the distribution of a taxon (see below).
This information may be linked to the taxon or a reference (see below). 

 

Choose either the list taxon or the reference in the tree and click on the  button to insert a
new distribution. The entries refer to the World geographical scheme for recoding plant
distributions. A form will open where you can choose geographical places from the module
DiversityGazetteer. To open the link to the module, click on the button and search for the
region as described in the chapter Module related entry.

If you need a certain region not provided in the list, just type the name of the region and click
OK.

 

Specimen

For every entry in a taxon list, you can document the collection specimen linked to this
taxonomic name (see below). The entries may be linked to the module DiversityCollection. To
enter a distribution for the specimen, use the button. A window will open (see above),
where you can select a geographic region as defined in the  World geographical scheme for
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recoding plant distributions.  

 

Export

To export the taxon lists resp. checklist, choose Data -> Export taxon list ... from the
menu. A window as shown below will open. By default the data will be exported as XML (see
below). Choose a schema file of your choice to convert the XML-output in a HTML document.
You have several options for the export in regard of the names as shown in the window below.
The export may be based on the names in the list and can be restricted to the accepted
names among these (see below - left). In the second option (see below - right), the accepted
names for all names in the list will be selected and the taxon list will contain only these names
and optionally their synonyms. Regarding the synonyms, if you want to suppress the export of
isonyms and duplicates, use the according checkbox. For long lists, the second method will be
rather time consuming, as the synonymy must be checked for every single name. The
synonymy for the exort may be derived from any available project. The path of the exported
file (either *.xml or *.html) is shown in the field Export file at the bottom of the form. The
names in the list may be sorted according to the names or the synonymy where synonyms will
be inserted after their assigned accepted names. The format the XML-export with a schema
file of your choice, choose the schema file and click on the button.
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The tables involved in the storage for the taxon list are documented in the taxon list tables
part. 
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Restriction of the access of users to taxonomic
lists
If the access of a user should be restricted to names within a taxonomic list, choose 
Administration - List user ... in the menu. A windows as shown below will open, where you
can add and remove lists thats should be accessible by a user. The users with no restriction
are listed in the left. To restrict a user to a certain list, choose the user in the  list, the list
the user should be restricted to and click on the > button. The lists a restricted user has
access to are listed in the list. To add or remove lists, use the < and > buttons.   

 

The tables involved in the storage for the taxon list are documented in the taxon list tables
part. 
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External databases
Most names in DiversityTaxonNames were imported from external sources. These sources are
documented in the area External data sources.

 
To enter or delete an external datasource, use the and button button respectively. With
the button you will get a detailed information about the external database. For a valid URI
you can use the button to open the corresponding website in a separate window. 

To edit the datasources themselve, choose m#TaxonNameExternalID"> TaxonNameExternalID
and TaxonNameExternalDatabase 
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Database
The database for DiversityTaxonNames is based on Microsoft SQL-Server 2008 or higher. The
names of the taxa were separated for practical reasons in several databases, each comprising
a certain range of taxa. There is one master version, DiversityTaxonNames, containing the
names of all databases and several databases containing the complete datasets including
synonymy, hierarchy etc. for the following groups:

Database Taxa Source
DiversityTaxonNames_Fungi higher fungi including lichens LIAS
DiversityTaxonNames_Myxomycetes slime moulds NomenMyx

DiversityTaxonNames_Plants higher plants Species 2000, Tropicos, IPNI,
Precis, ...

DiversityTaxonNames_Vertebrates vertebrates SAPM, ...

To access any database, you must specify the server where the database is located. For the

configuration of this connection click on the button or choose Connection, Database...
from the menu. If you got a new version of the client you can transfer the settings for the
previous version: Choose Connetion -> Transfer previous settings from the menu. (see
Database access for details)

Organisation of the data

The data are organised in several groups, data connected with the name, data based on the
opinion of an editor within a projects, the source of the data and the lists.

TaxonName, TaxonCommonName, TaxonNameTypification and TaxonGeography  are
containing the nomenclatural information. Most items are expected to be undisputed
nomenclatural facts. Some data items include editorial opinion (nomenclatural status, but also
the accepted spelling which may involve orthographical or grammatical corrections as required
by ICBN). However, it is expected that within a project agreement can be achieved on the
information contained in TaxonName, i.e. collaborators can "correct" information without
consultation.

TaxonNameProject document the projects of the names. The access for the users is
determined by the projects.

The tables TaxonHierarchy, TaxonNameResource, TaxonAcceptedName and
TaxonSynonymy - represent a higher level of taxonomic opinion, where different editors and
different digitized data sources need to be kept separate. This is achieved by making a
"Project" attribute part of the primary key. Editors that wish to collaborate and form
agreement may work in a single project, editors that desire to define separate opinions work in
separate projects. Furthermore, if the opinion is based on published information, the reference
and page number may be recorded (in ...RefText, ...RefID, ...RefDetail). The duality of
representing editorial opinion and remaining true to a digitized sources causes some problems.
For example, a species accepted in a referenced source may not longer be accepted by the
project editors. To avoid a further complication of the model, the
"IgnoreButKeepForReference" attribute (default "false") may be set to "true", indicating that
the statement is true from the perspective of the referenced source, but should be ignored
when representing editorial opinion. 

 TaxonHierarchy contains information about the hierarchical position of the taxa. For
each project, a name may be referred to a single parent taxon. The attribute
"NameParentID" may, however, be Null, in which case "HierarchyPositionIsUncertain"
should be true. 

 TaxonNameResource contains links to resources, e.g. images of the taxa. 
 TaxonAcceptedName contains the accepted names ("valid or preferred taxon

names"). For each project, a name in "TaxonName" may either be accepted (a
corresponding record in "TaxonAcceptedName" exists) or not. Examples for not
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accepted names are synonyms of accepted names and nomenclaturally rejected
names. 

 TaxonSynonymy contains names, which are synonym to other names. Here a single
name may be a synonym of multiple accepted names ("pro parte synonym"). The "pro
parte" or corresponding sensu information is captured in the "ConceptSuffix" attribute,
which is part of the primary key. 

TaxonNameExternalID and TaxonNameExternalDatabase document the sources of the
names.

The tables TaxonNameList... contain informations connected to e.g. checklists. In addition
to the restriction to projects the access of users may be restricted to certain lists. 

 

Overview of the main tables of the database
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For details about the tables see Data tables.
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Installation of the database
DiversityTaxonNames uses Microsoft SQL-Server 2008 or later as database engine. If you do
not have a database server with DiversityTaxonNames already available, you have to install
the database engine first. Download the free version of Microsoft SQL Server Express 2008 or
later (e.g. SQLEXPRADV_x86_DEU.exe  ) from http://www.microsoft.com/downloads/.. Start
the program and follow the instructions for the installation. 

Download the database files DiversityTaxonNames_Data.MDF  and
DiversityTaxonNames_log.LDF  from http://www.diversityworkbench.net/Portal/ provided as
a zip archive (DiversitTaxonNames.zip) and copy them into your database directory. 

 

Server configuration 

To configure your server for remote access, launch the SQL Server Configuration Manager
(see image below). 

Then click on the "Protocols for SQLEXPRESS" node. Right click on "TCP/IP" in the list of
Protocols and choose "enable" for TCP/IP.

Right click on the TCP/IP node and select, "Properties" to open a window as shown below. 
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In the part IPALL clear out the value for "TCP Dynamic Ports". Give a TCP-Port number to
use when making remote connections, e.g. "4321" as shown above. You have to restart the
SQL Server Express service before you can connect to your database. 

If you use a database on a server, make sure that the firewall of the server allows access via
the port you set for the connections (see below). 
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Start the Microsoft SQL Server Managment Studio and attach the database as shown below.
Choose the node "databases" and right-click on it to open the context menu (see below).
Then choose "attach" from the context menu. A window will open where you can choose the
file DiversityTaxonNames_Data.MDF from your database directory and attach it to the
database engine.
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After the installation make shure to get the latest updates from 
http://windowsupdate.microsoft.com/.

 

Database configuration 

To configure your Database, use the Client as described in Database configuration.
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Configuratation of the database
To configure your Database, choose Administration -> Rename database to change the
name of the database according to your requirements. During this renaming all processes in
the database will be terminated (you will get a warning if processes from other host are
active). 

Afterwards you should adapt the address that is published by the database for access by
other modules. Choose Administration -> Set published address from the menu. This will
change the published address to the name of the server where your database is located and
an identifier for you database, e.g. http://xy.diversityworkbench.de/TaxonNames/ .  
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Database tables
The description of the tables and the fields

Index
 TaxonAcceptedName

 TaxonCommonName

 TaxonGeography

 TaxonHierarchy

 TaxonName

 TaxonNameExternalDatabase

 TaxonNameExternalID

 TaxonNameList

 TaxonNameListAnalysis

 TaxonNameListAnalysisCategory

 TaxonNameListAnalysisCategoryValue

 TaxonNameListArea

 TaxonNameListCollectionSpecimen

 TaxonNameListDistribution

 TaxonNameListReference

 TaxonNameProject

 TaxonNameReference

 TaxonNameResource

 TaxonNameTypification

 TaxonSynonymy

Table TaxonAcceptedName
TaxonAcceptedName contains the accepted names ("valid or preferred taxon
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names"). For each project, a name in "TaxonName" may either be accepted
(a corresponding record in "TaxonAcceptedName" exists) or not. Examples
for not accepted names are synonyms of accepted names and
nomenclaturally rejected names.

Column Data type Description Nullable Relation

ProjectID int

Each project
can have a
different opinion
regarding
synonmy. Refers
to the common
project definition
in the
DiversityProjects
module.
Default value: 0

NO

Refers to table
ProjectProxy and
table
TaxonNameProjec
t

NameID int

ID of the
accepted name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO
Refers to table
TaxonNameProjec
t

IgnoreButKeepForReferenc
e tinyint

If true, the
record is ignored
for all purposes
of evaluation
(because
contradicted). It
is kept only to
maintain the
cited reference.
If no reference
is given, it may
be deleted
instead.
Default value: 0

NO -

ConceptSuffix nvarchar
(200)

Empty for
default and
primary
concept; else 's.
lat.', 's. str.',
'sec.', 'sensu
Muell.', 'emend.'
, '(Auct.)' etc.
Default value: ''

YES -

ConceptNotes nvarchar
(500)

Notes on the
concept of the
name, e.g. incl.
forms with black
apothecia

YES -

RefURI varchar (255)

ReferenceURI:
Source
publication
where
synonymization
is published (not

YES -
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publication of
name!)

RefText nvarchar
(255)

Free text, esp.
where a RefURI
is missing.
Source
publication
where
synonymization
is published (not
publication of
name!)

YES -

RefDetail nvarchar
(255)

Esp. page
number on which
the
synonymization
is published

YES -

TypistsNotes nvarchar
(255)

An internal note
of the
responsible
person
concerning this
synonymization.
This information
is NOT included
in any report.

YES -

LogInsertedBy nvarchar (50)

Name of user
who first
entered (typed
or imported) the
data. This is the
operator (or
typist) name,
which may be
different from
the person
responsible.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when record
was first
entered (typed
or imported) into
this system.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user
who last
updated the
data. This is the
operator (or
typist) name,
which may be
different from
the person
responsible.

YES -
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Default value:
user_name()

LogUpdatedWhen smalldatetime

Date and time
when record
was last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifie
r

-
Default value:
newsequentialid(
)

YES -

Table TaxonCommonName
TaxonCommonName contains the common names that are assigned to a
scientific name.

Column Data type Description Nullable Relation

NameID int

ID taxonomic
name. Refers to
the column
NameID of the
table TaxonName
(= foreign key).

NO Refers to table
TaxonName

CommonName nvarchar (220)
A common name
of the taxonomic
name

NO -

LanguageCode varchar (2)

The 2-letter code
of the language
of the common
name according
to ISO

NO
Refers to table
LanguageCode_E
num

CountryCode varchar (2)

The 2-letter code
of the country
where the
common name is
used according to
ISO ISO 3166-1 

NO
Refers to table
CountryCode_Enu
m

ReferenceTitle nvarchar (220)

The title of the
reference where
the common
name was
published

NO -

ReferenceURI varchar (255)

The URI of the
reference e.g. as
provided by the
module
DiversityReferenc
es

YES -

ReferenceDetails nvarchar (500)

Esp. page number
on which the
common name is
published

YES -
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SubjectContext nvarchar (500)

The context in
which the
common name is
used, e.g.
pharmacy, food

YES -

Transliteration nvarchar (255) - YES -

Notes nvarchar (MAX) Notes about the
common name

YES -

LogInsertedBy nvarchar (50)

Who inserted this
dataset
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

The time when
this dataset was
inserted
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Who was the last
to update this
dataset
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

The last time
when this
dataset was
updated
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonGeography
TaxonGeography is containing the information about the geographic
distribution according to the protologue. 

Column Data type Description Nullable Relation

NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO Refers to table
TaxonName

PlaceURI varchar (255)

URI (e.g. LSID)
within e.g. the
DiversityGazettee
r for a place
(which may have
several names)
as found in the
protologue

NO -

PlaceNameCache nvarchar (100) The name of the
place

NO -
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LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonHierarchy
TaxonHierarchy contains information about the hierarchical position of the
taxa. For each project, a name may be referred to a single parent taxon.
The attribute "NameParentID" may, however, be Null, in which case
"HierarchyPositionIsUncertain" should be true.

Column Data type Description Nullable Relation

ProjectID int

Each project can
implement a
different
taxonomic
hierarchy. Refers
to the common
project definition
in the
DiversityProjects
module.
Default value: 0

NO

Refers to table
ProjectProxy and
table
TaxonNameProjec
t

NameID int

Unique NameID
code of the
higher taxon.
Refers to the
NameID code of
LichenName (=

NO
Refers to table
TaxonNameProjec
t
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foreign key).

IgnoreButKeepF
orReference tinyint

If true, the
record is ignored
for all purposes of
evaluation
(because
contradicted). It
is kept only to
maintain the
cited reference.
If no reference is
given, it may be
deleted instead.
Default value: 0

NO -

NameParentID int

Next higher taxon
(e.g. the family
or subfamily if
this taxon is a
genus)

YES -

HierarchyRefURI varchar (255)

Reference URI:
Source
publication where
the hierarchy is
published (not
publication of
name!) as stored
e.g. in
DiversityReferenc
es

YES -

HierarchyRefText nvarchar (255)

Free citation,
esp. where a
HierarchyRefURI
is missing. Source
publication where
the hierarchy is
published (not
publication of
name!)

YES -

HierarchyRefDetai
l nvarchar (255)

Esp. page number
on which the
hierarchy is
published

YES -

HierarchyPositionI
sUncertain bit

If the position of
this taxon within
this taxonomic
group is
uncertain.
Default value: 0

YES -

HierarchyTypistsN
otes nvarchar (255)

An internal note
of the responsible
person
concerning this
hierarchy. This
information is
NOT included in
any report.

YES -

HierarchyListCach nvarchar (1000) CALCULATED YES -
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e

FIELD: List of
higher taxa for
faster access:
"div.; class; ord.;
fam."

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when record was
first entered
(typed or
imported) into
this system.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when record was
last updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonName
TaxonName is the nomenclatural information. Most items are expected to
be undisputed nomenclatural facts. Some data items include editorial
opinion (nomenclatural status, but also the accepted spelling which may
involve orthographical or grammatical corrections as required by ICBN).
However, it is expected that within a project agreement can be achieved on
the information contained in TaxonName, i.e. collaborators can "correct"
information without consultation.
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Column Data type Description Nullable Relation

NameID int

The ID of a name
in
DiversityTaxonNa
mes_Fungi
(primary key)

NO -

TaxonNameCache nvarchar (255)

A full unique
version of the
name. Generated
by the database,
not entered by
the user
(candidate key)

YES -

Version smallint

The version of a
name record
(revision number,
internally filled by
system)
Default value: (1)

YES -

BasedOnNameID int

The Basionym of
this name, resp.
the NameID of
the Basionym. A
name is a
Basionym, if
NameID =
BasionymID.

YES Refers to table
TaxonName

CreationType nvarchar (50)

E.g.: taxon based
on new type,
combination
based on a
previously publ.
name ('comb.
nov.'), new name
('nom.nov.')
introduced to
replace a
homonym (may
occur for
genera!),
validation of
previously
invalidly publ.
taxon name
('ex'), or
unknown.

YES
Refers to table
TaxonNameCreati
onType_Enum

TaxonomicRank nvarchar (50)

Taxonomic rank
of the taxon
(var., subsp.,
species, genus,
family, order,
etc.). The rank
must be selected
from the
associated list of
ranks (=
TaxonomyRank)

NO
Refers to table
TaxonNameTaxon
omicRank_Enum
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Default value:
N'sp.'

GenusOrSupragen
ericName nvarchar (200)

If rank is above
species: Name of
taxon above
species level
(currently
accepted
spelling). Includes
infrageneric taxon
names, genera,
families, etc.

NO -

SpeciesGenusNam
eID int

If rank is species
or below: NameID
of the Genus
name. Refers to
same table with
TaxonomicRank =
genus.

YES Refers to table
TaxonName

InfragenericEpith
et nvarchar (200)

If rank below
genus and above
species: Name of
infrageneric taxon
above species
level (currently
accepted
spelling). Includes
subgenus, series,
etc.

YES -

SpeciesEpithet nvarchar (100)

The species name
part of the
species name, for
example 'alba' in
'Abies alba'.

YES -

InfraspecificEpith
et nvarchar (100)

The epithet of
the infraspecific
entity

YES -

BasionymAuthors nvarchar (100)

The authors of a
newly created
name. For all
taxonomic ranks,
only for 'comb.
nov.' or 'nom.
nov.': Author(s)
of the basionym
(will be displayed
in '()', do not
enter the
parentheses),
abbreviated
according to
authors standard

YES -

CombiningAuthors nvarchar (255)

The names of the
combining
authors if the
name is base on
another older

YES -
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name (e.g.
combined into a
different genus)

PublishingAuthors nvarchar (255)

If the authors of
the taxon differ
from the authors
of the
publication: the
latter (...'in '
Publishing authors
... )

YES -

SanctioningAutho
r nvarchar (100)

Sanctioning is a
special
instrument
available for fungi
to allow the
starting date of
taxonomy to be
identical with
higher plants, but
preserve names
used by Fries
(Fr.) and Person
(Pers.)

YES -

NonNomenclatural
NameSuffix nvarchar (200)

A suffix for
concept names
not included in
any
nomenclatural
code. If present
fields for authors
and typification
must be empty
and
NomenclaturalCod
e set to 'not
under code'.

YES -

IsRecombination bit

True if the name
is a
recombination
Default value: (0)

NO -

IsHybrid bit

If checked (or
'True'), the new
taxon is a hybrid
with or without a
hybrid epithet.
Default value: (0)

YES -

HybridNameID1 int

If IsHybrid is
checked (or
'True'): Name of
hybrid species 1.
Refers to NomID
code of publ.
TaxonomyName
(= foreign key).

YES Refers to table
TaxonName

HybridNameID2 int If IsHybrid is
checked (or YES Refers to table

TaxonName
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'True'): Name of
hybrid species 2.
Refers to NomID
code of publ.
TaxonomyName
(= foreign key).

HybridNameID3 int

If IsHybrid is
checked (or
'True'): Name of
hybrid species 3.
Refers to NomID
code of publ.
TaxonomyName
(= foreign key).

YES Refers to table
TaxonName

HybridNameID4 int

If IsHybrid is
checked (or
'True'): Name of
hybrid species 4.
Refers to NomID
code of publ.
TaxonomyName
(= foreign key).

YES Refers to table
TaxonName

ReferenceTitle nvarchar (600)

The title of the
publication where
the name was
published. Note
this is only a
cached value
where
ReferenceURI is
present

YES -

ReferenceURI varchar (255)

URI (e.g. LSID) of
Reference,
referes to table
ReferenceTitle in
Database
DiversityReferenc
es: Source
publication where
name is published

YES -

Volume nvarchar (20) The volume of
the journal

YES -

Issue nvarchar (255) The issue of the
literature

YES -

Pages nvarchar (50) The pages within
the literature

YES -

DetailLocation nvarchar (200)
Additional
information like
plates etc.

YES -

DayOfPubl tinyint
The day when
the name was
published

YES -

MonthOfPubl tinyint
The month when
the name was
published

YES -

YearOfPubl smallint The year when YES -

Page 219



the name was
published

DateOfPublSupple
ment nvarchar (200)

Verbal or
additional date
information, e.g.
'end of summer
1985', 'first
quarter',
'1888-1892'

YES -

YearOnPubl smallint

The year cited on
the original paper
as year of
publication

YES -

DateOnPublSuppl
ement nvarchar (200)

Verbal or
additional date
information, e.g.
'end of summer
1985', 'first
quarter',
'1888-1892'

YES -

Protologue nvarchar (MAX)

Full text of the
protologue. If
protologue is
provided in Latin
and in another
language
languages, both
only the Latin or
several languages
may be stored
together.

YES -

ProtologueURI varchar (255)

URI of externally
available
Protologue
information
(scanned image,
full text from
external provider,
etc.)

YES -

ProtologueResour
ceURI varchar (255)

The ResourceID
of an image of
the protologue as
stored in the
module
DiversityResource
s. Primary key of
table Resource in
the database
DiversityResource
s.(= Foreign key)

YES -

NameUsageRefere
nces nvarchar (255)

Indexing volumes
like Index of
Fungi or any
Name usage that
caused this name
to be added to
the database 

YES -
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OriginalOrthograp
hy nvarchar (255)

The original
spelling of the
name

YES -

NomenclaturalCod
e nvarchar (50)

Code of
Nomenclature
under which this
taxon was
created:
'Bacteriology',
'Botany' (incl.
Mycology),
'Zoology',
'Biocode' (for
future use), 'Non
nomenclatural
name'. Default
value: 'Botany'

YES

Refers to table
TaxonNameNome
nclaturalCode_En
um

NomenclaturalSta
tus nvarchar (50)

Categories for
effective/valid/le
gitimate... esp.
'nom. illeg.', 'nom.
inval.', 'nom.
nudum', etc.

YES

Refers to table
TaxonNameNome
nclaturalStatus_E
num

NomenclaturalCo
mment nvarchar (MAX)

Comments on the
nomenclature.
e.g. 'according to
ICBN Art. 39.1'

YES -

Typification nvarchar (50)

The status of the
type specimen(s)
as written in the
protologue, e.g.
holotype

YES -

TypificationDetail
s nvarchar (255)

Details
concerning the
typification as
written in the
protologue, e.g. if
just parts of a
specimen were
accepted as the
type

YES -

TypificationRefere
nceTitle nvarchar (255)

The title of the
publication where
the typification
was published.
Note this is only
a cached value
where
Typification-Liter
atureLink is
present

YES -

TypificationRefere
nceURI varchar (255)

URI (e.g. LSID) of
Reference, refers
to e.g
DiversityReferenc
es: Source
publication where

YES -
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the typification is
published

TypificationNotes nvarchar (200) Notes concerning
the typification

YES -

TypeSubstrate nvarchar (255)

The substrate
the type was
growing on as
written in the
protologue

YES -

TypeLocality nvarchar (255)

The locality
where the type
was found as
written in the
protologue

YES -

TypeSpecimenNot
es nvarchar (200)

Notes about the
type specimen,
e.g. the
herbarium where
a type specimen
is located,
Collector,
collection
date/number,
etc.

YES -

AnamorphTeleom
orph nvarchar (255)

If the name is
related to a
anamorph or a
teleomorph as
written in the
protologue

YES -

TypistNotes nvarchar (200) Additional notes
and problems

YES -

RevisionLevel nvarchar (50)

The level of the
revision of the
taxonomic name,
e.g. 'unchecked',
'fully checked'

YES
Refers to table
TaxonNameRevisi
onLevel_Enum

IgnoreButKeepFor
Reference bit

If true, the
record is ignored
for all purposes of
evaluation
(because
contradicted). It
is kept only to
maintain the
cited reference.
If no reference is
given, it may be
deleted instead.
Default value: (0)

YES -

DataWithholdingR
eason nvarchar (255)

If the dataset is
withhold, the
reason for
withholding the
data, otherwise
null

YES -
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LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when record was
first entered
(typed or
imported) into
this system.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when record was
last updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

BasionymAuthors
Year int

The year when
the name was
published by the
authors of the
Basionym

YES -

Table TaxonNameExternalDatabase
TaxonNameExternalDatabase document the sources of the names.

Column Data type Description Nullable Relation

ExternalDataba
seID int

An ID to identify
an external data
collection of plant
names (primary

NO -
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key, the ID has
no meaning
outside of the
DiversityWorkben
ch system)

ExternalDatabase
Name nvarchar (255)

The name of the
data collection
that has been
integrated or can
be linked to for
further analysis

YES -

ExternalDatabase
Version nvarchar (255)

The version of
this data
collection (either
official version
number, or dates
when the
collection was
integrated)

YES -

Rights nvarchar (500)

A description of
copyright
agreements or
permission to use
data from the
external database

YES -

ExternalDatabase
Authors nvarchar (200)

The persons or
institutions
responsible for
the external
database

YES -

ExternalDatabase
URI nvarchar (300)

The URI of the
database provider
resp. the external
database

YES -

ExternalDatabase
Institution nvarchar (300)

The institution
responsible for
the external
database

YES -

InternalNotes nvarchar (1500)
Additional notes
concerning this
data collection

YES -

ExternalAttribute
_NameID nvarchar (255)

The table and
field name in the
external data
collection to
which
TaxonNameExtern
alID refers

YES -

PreferredSequenc
e tinyint

For selection in
e.g. picklists: of
several equal
names only the
name from the
source with the
lowest preferred
sequence will be

YES -
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provided.

Disabled bit

If this source
should be
disabled for
selection of
names e.g. in
picklists

YES -

LogCreatedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogCreatedWhen datetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen datetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameExternalID
TaxonNameExternalID document the source of a name together with the ID
of the source.

Column Data type Description Nullable Relation

NameID int

The ID of a name
in
DiversityTaxonNa
mes (foreign key
+ part of primary
key: the name
string associated
with NameID may
occur in multiple
external
databases)

NO Refers to table
TaxonName
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ExternalDataba
seID int

The ID of an
external
taxonomic data
collection as
defined in
TaxontNameExter
nalDatabase
(foreign key +
part of primary
key)

NO
Refers to table
TaxonNameExtern
alDatabase

ExternalNameURI varchar (255)

The URI (e.g. a
LSID) of the
external name as
defined in the
external database

YES -

LogCreatedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogCreatedWhen datetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen datetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameList
The table is containing the names listed in e.g. a checklist corresponding to
the project.

Column Data type Description Nullable Relation

NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=

NO Refers to table
TaxonName
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foreign key).

ProjectID int

Each project can
may contain one
taxon list. Refers
to the common
project definition
in the
DiversityProjects
module.

NO
Refers to table
TaxonNameListPr
ojectProxy

Notes nvarchar (MAX)
An note
concerning this
entry.

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameListAnalysis
Analysis values for list entries in the database, "Red list category: R",
"Time of observation: Sept. - Nov."

Column Data type Description Nullable Relation

NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO

Refers to table
TaxonNameList
and table
TaxonNameListRe
ference

ProjectID int Each project can NO Refers to table
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may contain one
taxon list. Refers
to the common
project definition
in the
DiversityProjects
module.

TaxonNameList
and table
TaxonNameListRe
ference

TaxonNameList
RefID int

Unique ID of the
reference within
the list, refers to
table
TaxonNameListRe
ference, part of
primary key
Default value:
(-1)

NO
Refers to table
TaxonNameListRe
ference

AnalysisID int ID of the analysis
(= foreign key) NO

Refers to table
TaxonNameListAn
alysisCategory

AnalysisValue nvarchar (255) The result of the
analysis

YES -

Notes nvarchar (MAX) Notes concerning
this analysis

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameListAnalysisCategory
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Analysis types used within the database, e.g. "Red list category",
"Frequency"

Column Data type Description Nullable Relation

AnalysisID int ID of the analysis
(Primary key) NO -

AnalysisParentID int

Analysis ID of the
parent analysis if
it belongs to a
certain type
documented in
this table

YES -

DisplayText nvarchar (50)

Name of the
analysis as e.g.
shown in user
interface

YES -

Description nvarchar (MAX) Description of the
analysis YES -

AnalysisURI varchar (255)

URI referring to
an external
documentation of
the analysis

YES -

Notes nvarchar (MAX) Notes concerning
this analysis YES -

LogCreatedWhen datetime

The time when
this dataset was
created
Default value:
getdate()

YES -

LogCreatedBy nvarchar (50)

Who created this
dataset
Default value:
user_name()

YES -

LogUpdatedWhen datetime

The last time
when this
dataset was
updated
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Who was the last
to update this
dataset
Default value:
user_name()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameListAnalysisCategoryValue
Value lists for analysis types with predefined values, e.g. "0, 1, 2, 3, ..." for
Red list category. Includes description etc. for the values in the list.
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Column Data type Description Nullable Relation

AnalysisID int ID of the analysis
(Primary key) NO

Refers to table
TaxonNameListAn
alysisCategory

AnalysisValue nvarchar (255)
The categorized
value of the
analysis

NO -

Description nvarchar (500)

Description of
enumerated
object, displayed
in the user
interface

YES -

DisplayText nvarchar (50)

Short abbreviated
description of the
object, displayed
in the user
interface

YES -

DisplayOrder smallint

The order in
which the entries
are displayed.
The order may be
changed at any
time, but all
values must be
unique.

YES -

Notes nvarchar (500)

Internal
development
notes about
usage, definition,
etc. of an
enumerated
object

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.

YES -
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Default value:
getdate()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameListArea
The area defined for the whole taxon list

Column Data type Description Nullable Relation

ProjectID int

Each project can
have a different
opinion regarding
the parameters
defined for a list.
Refers to the
common project
definition in the
DiversityProjects
module.

NO
Refers to table
TaxonNameListPr
ojectProxy

PlaceURI varchar (255)

URI or identifier
for a place
(which may have
several names)
derived from e.g.
TDWG

NO -

PlaceNameCache nvarchar (255) The name of the
place

YES -

Notes nvarchar (MAX)
An note
concerning this
entry.

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime Date and time
when the data YES -
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were last
updated.
Default value:
getdate()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameListCollectionSpecimen
The collection specimens on which the taxon list is based

Column Data type Description Nullable Relation

NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO Refers to table
TaxonNameList

ProjectID int

ProjectID of the
taxon list. Foreign
key and part of
primary key. 

NO Refers to table
TaxonNameList

DisplayText varchar (255)

The name of the
collection
specimen as
shown e.g. in a
user interface.
Part of the
primary key

NO -

CollectionSpecime
nURI varchar (255)

URI of the
collection
specimen. May
refer to the
module
CollectionSpecime
n

YES -

Role nvarchar (50)

The role of the
specimen in
relation to the
taxon list (=
foreign key, see
table
TaxonNameListSp
ecimenRole_Enum
)

YES
Refers to table
TaxonNameListSp
ecimenRole_Enum

Description nvarchar (MAX)
Description of the
collection
specimen

YES -

PlaceURI varchar (255)

URI or identifier
for a place
(which may have
several names)
derived from e.g.
TDWG

YES -
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PlaceNameCache nvarchar (255) The name of the
place

YES -

Notes nvarchar (MAX)
Notes about the
collection
specimen

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameListDistribution
The geographical distrbution for the organisms within the taxon list.

Column Data type Description Nullable Relation

NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO

Refers to table
TaxonNameList
and table
TaxonNameListRe
ference

ProjectID int

Each project can
may contain one
taxon list. Refers
to the common
project definition
in the
DiversityProjects
module.

NO

Refers to table
TaxonNameList
and table
TaxonNameListRe
ference

TaxonNameList int Unique ID of the NO Refers to table
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RefID

reference within
the list, refers to
table
TaxonNameListRe
ference, part of
primary key
Default value:
(-1)

TaxonNameListRe
ference

PlaceURI varchar (255)

URI or identifier
for a place
(which may have
several names)
derived from e.g.
TDWG
Default value: ''

NO -

PlaceNameCach
e nvarchar (255)

The name of the
place
Default value: ''

NO -

Notes nvarchar (MAX) Notes concerning
this analysis

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameListReference
The reference where the taxon list resp. the name is published

Column Data type Description Nullable Relation
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NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO Refers to table
TaxonNameList

ProjectID int

Each project can
may contain one
taxon list. Refers
to the common
project definition
in the
DiversityProjects
module.

NO Refers to table
TaxonNameList

TaxonNameList
RefID int

Unique ID of the
reference within
the list, part of
primary key

NO -

TaxonNameListRe
fText nvarchar (255)

Free text, esp.
where a
TaxonNameListRe
fURI is missing.
Source
publication where
distribution is
published (not
publication of
name!)

NO -

TaxonNameListRe
fURI varchar (255)

Reference URI:
Source
publication where
the distribution is
published (not
publication of
name!) as stored
e.g. in
DiversityReferenc
es

YES -

TaxonNameListRe
fDetail nvarchar (255)

Esp. page number
on which the
distribution is
published

YES -

ReferenceType nvarchar (50)
The type of the
reference, e.g. a
webpage

YES

Refers to table
TaxonNameListRe
ferenceType_Enu
m

TaxonUsageConte
xt nvarchar (50)

The context of
the usage of the
taxonomic name
within the
reference, e.g.
ecology

YES -

Notes nvarchar (MAX)
An note
concerning this
entry.

YES -

LogInsertedBy nvarchar (50) Name of user who
first entered YES -
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(typed or
imported) the
data.
Default value:
user_name()

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameProject
TaxonNameProject documents the projects of the names and provides
access to the data.

Column Data type Description Nullable Relation

NameID int

The ID of a name
in
DiversityTaxonNa
mes (foreign key
+ part of primary
key: the name
may occur in
multiple projects)

NO Refers to table
TaxonName

ProjectID int

ID of the project.
Refers to the
common project
definition in the
DiversityProjects
module.
Default value: 0

NO Refers to table
ProjectProxy

LogInsertedWhen datetime

The time when
this dataset was
inserted
Default value:
getdate()

YES -

Page 236



LogInsertedBy nvarchar (50)

Who inserted this
dataset
Default value:
user_name()

YES -

LogUpdatedWhen datetime

The last time
when this
dataset was
updated
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Who was the last
to update this
dataset
Default value:
user_name()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameReference
References related to a taxonomic name

Column Data type Description Nullable Relation

NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO Refers to table
TaxonName

TaxonNameRefI
D int

Unique ID of the
reference, part of
primary key

NO -

TaxonNameRefTe
xt

nvarchar (500) The citation text
of the reference

NO -

TaxonNameRefURI varchar (500)

Reference URI:
Link to the
source where the
publication as
stored e.g.
DiversityReferenc
es

YES -

TaxonNameRefDe
tail nvarchar (255)

Esp. page number
on which the
distribution is
published

YES -

ReferenceType nvarchar (50)
The type of the
reference, e.g. a
webpage

YES

Refers to table
TaxonNameListRe
ferenceType_Enu
m

Notes nvarchar (MAX)
An note
concerning this
entry.

YES -

LogInsertedBy nvarchar (50) Name of user who YES -

Page 237



first entered
(typed or
imported) the
data.
Default value:
user_name()

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameResource
Resouces related to the taxonomic name

Column Data type Description Nullable Relation

NameID int

ID of the name.
Refers to the
NameID of
TaxonName (=
foreign key).

NO
Refers to table
TaxonNameProjec
t

ProjectID int

ID of the project.
Refers to the
common project
definition in the
DiversityProjects
module.

NO
Refers to table
TaxonNameProjec
t

URI varchar (255)
The complete URI
address of the
resource. 

NO -

Description xml (MAX) Description of the
resource

YES -

Notes nvarchar (MAX)
A note
concerning this
entry.

YES -

LogInsertedBy nvarchar (50) Name of user who YES -
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first entered
(typed or
imported) the
data.
Default value:
user_name()

LogInsertedWhen smalldatetime

Date and time
when the data
were first entered
(typed or
imported) into
this database.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when the data
were last
updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonNameTypification
The typification of a taxonomic name, e.g. where the type information of
the name was published 

Column Data type Description Nullable Relation

NameID int

The ID of a name
in
DiversityTaxonNa
mes_Fungi
(primary key)

NO Refers to table
TaxonName

TypificationRefe
renceTitle nvarchar (255)

The title of the
publication where
the typification
was published.
Note this is only
a cached value
where
Typification-Liter
atureLink is
present

NO -

TypificationRefere
nceURI varchar (255)

URI (e.g. LSID) of
Reference, refers
to e.g
DiversityReferenc
es: Source

YES -
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publication where
the typification is
published

Typification nvarchar (500)

The status of the
type specimen(s)
as written in the
protologue, e.g.
holotype

YES -

TypificationDetail
s nvarchar (255)

Details
concerning the
typification as
written in the
protologue, e.g. if
just parts of a
specimen were
accepted as the
type

YES -

TypificationNotes nvarchar (200) Notes concerning
the typification

YES -

TypeSubstrate nvarchar (255)

The substrate
the type was
growing on as
written in the
protologue

YES -

TypeLocality nvarchar (255)

The locality
where the type
was found as
written in the
protologue

YES -

TypeSpecimenNot
es nvarchar (500)

Notes about the
type specimen,
e.g. the
herbarium where
a type specimen
is located,
Collector,
collection
date/number,
etc.

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when record was
first entered
(typed or
imported) into

YES -
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this system.
Default value:
getdate()

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when record was
last updated.
Default value:
getdate()

YES -

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -

Table TaxonSynonymy
TaxonSynonymy contains names, which are synonym to other names. Here
a single name may be a synonym of multiple accepted names ("pro parte
synonym"). The "pro parte" or corresponding sensu information is captured
in the "ConceptSuffix" attribute, which is part of the primary key.

Column Data type Description Nullable Relation

ProjectID int

Each project can
have a different
opinion regarding
synonmy. Refers
to the common
project definition
in the
DiversityProjects
module.
Default value: (0)

NO

Refers to table
ProjectProxy and
table
TaxonNameProjec
t

NameID int

ID of the
synonymized
name. Refers to
the NameID of
TaxonName (=
foreign key).

NO
Refers to table
TaxonNameProjec
t

SynNameID int

The ID of the
synonym to
which this name
has been
assigned to.
Refers to the
NameID of
TaxonName (=

NO
Refers to table
TaxonNameProjec
t
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foreign key).

IgnoreButKeepF
orReference tinyint

If true, the
record is ignored
for all purposes of
evaluation
(because
contradicted). It
is kept only to
maintain the
cited reference.
If no reference is
given, it may be
deleted instead.
Default value: (0)

NO -

ConceptSuffix nvarchar (200)

Empty for default
and primary
concept; else 's.
lat.', 's. str.',
'sec.', 'sensu
Muell.', 'emend.' ,
'(Auct.)' etc.
Default value: ''

YES -

ConceptNotes nvarchar (500)

Notes on the
concept of the
name, e.g. incl.
forms with black
apothecia

YES -

SynRefURI varchar (255)

Reference URI:
Source
publication where
synonymization is
published (not
publication of
name!) as stored
e.g. in
DiversityReferenc
es

YES -

SynRefText nvarchar (255)

Free text, esp.
where a
SynRefURI is
missing. Source
publication where
synonymization is
published (not
publication of
name!)

YES -

SynRefDetail nvarchar (255)

Esp. page number
on which the
synonymization is
published

YES -

SynTypistsNotes nvarchar (255)

An internal note
of the responsible
person
concerning this
synonymization.
This information
is NOT included in

YES -
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any report.

SynType nvarchar (50)

Type of the
synonymization,
e.g. 'heterotypic',
'homotypic'
Default value:
'unknown'

NO

Refers to table
TaxonNameSynon
ymisationType_En
um

SynIsUncertain bit

If the
synoymization is
uncertain.
Corresponding to
=? for
heterotypic
synonyms and ? if
the type of the
synonymisation is
unknown.
Homotypic
synonyms can
not be uncertain.
Default value: (0)

YES -

LogInsertedBy nvarchar (50)

Name of user who
first entered
(typed or
imported) the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogInsertedWhen smalldatetime

Date and time
when record was
first entered
(typed or
imported) into
this system.
Default value:
getdate()

YES -

LogUpdatedBy nvarchar (50)

Name of user who
last updated the
data. This is the
operator (or
typist) name,
which may be
different from the
person
responsible.
Default value:
user_name()

YES -

LogUpdatedWhen smalldatetime

Date and time
when record was
last updated.
Default value:

YES -
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getdate()

RowGUID uniqueidentifier
-
Default value:
newsequentialid()

YES -
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History

To inspect the history of a dataset click on the button. A form will open, showing all
former states of the data in the tables with the current dataset at the top.

  

The version will be set automatically. If a dataset is changed the version will be increased if
the last changes where done by a different user or the last change is more than 24 hours ago
(for further details see topic Logging ).
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Statistics
To see the activity and the state of revision within a project choose Help - Statistics ... from
the menu. A form as shown below will open containing a summary of the project, for the
current user and for lists.

 

To see the statistics for a list, select it in the combobox. After the selection the statistics are
generated (see below). 
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Backup
If you need to backup your database, choose Data - Backup database ... from the menu
and follow the instructions. 

Another option is to use the functionality provided by SQL-Server. To do this, you need
administration rights in the database you want to create a backup. Open the Enterprise
Manager for SQL-Server, choose the database and detach it from the server as shown in the
image below.

After detaching the database, you can store a copy of the ..._Data.MDF File to keep it as a
backup.

After storing the backup you have to attach the database.

A dialog will appear where you have to select the original database file in your directory.
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Logging
Changes within the database will be documented for each dataset with the time and the
responsible user in the columns shown in the image below.

All main tables have a corresponding logging table. If you change or delete a dataset the
orignial dataset will be stored in this logging table together with information about who has
done the changes and when it happend. To inspect the history of a dataset click on the 

button (see topic History for further information)

 

The logging tables (right side in image below) have the same structure as the data tables (left
side in image below)  and some additional fields (LogState, LogDate, LogUser, LogVersion and
LogID) to document the logging as shown in the figure below.

 

The field LogVersion is only present in tables dependent on a version main table. This main
table keeps the version valid for the dataset including data in dependent tables. If a dataset
in a dependent table is changed, the version of the main table will be updated and the entries
in the logging table for the dependent table will record the version of the main table before
the changes took place.

Page 250


	DiversityWorkbench
	Modules
	Module related entry
	Projects
	References
	Specimen


	DiversityTaxonNames
	Installation
	Login administration
	Login
	Version
	Feedback
	Export
	Export wizard
	Transformation
	Tutorial

	Export hierarchy
	Export lists

	Import
	Import list
	Import wizard
	Columns
	Transformations
	Tutorial: 1 - Taxa
	2 - Higher taxa
	3 - Hierarchy
	4 - Hierarchy
	5 - Synonyms



	Menu
	Manual
	Archive
	Maintenance
	Query
	Query options
	Wildcards

	Data / Editing
	List view
	Edit taxa in list
	Data handling
	Taxonomic name
	Authors
	Nomenclature
	Protologue
	Typification
	Hybrids
	Synonymy
	Hierarchy
	Common names
	Ignored data
	Geography
	Resources
	References
	Taxon lists
	Taxon list user
	External databases

	Database
	Installation
	Configuration
	Data tables
	History
	Statistics
	Backup
	Logging



